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Dear learner,

I extend my heartfelt greetings and profound enthusiasm as I warmly 
welcome you to Sreenarayanaguru Open University. Established in 
September 2020 as a state-led endeavour to promote higher educa-
tion through open and distance learning modes, our institution was 
shaped by the guiding principle that access and quality are the corner-
stones of equity. We have firmly resolved to uphold the highest stan-
dards of education, setting the benchmark and charting the course.

The courses offered by the Sreenarayanaguru Open University aim 
to strike a quality balance, ensuring students are equipped for both 
personal growth and professional excellence. The University embraces 
the widely acclaimed “blended format,” a practical framework that 
harmoniously integrates Self-Learning Materials, Classroom Counsel-
ing, and Virtual modes, fostering a dynamic and enriching experience 
for both learners and instructors.

The University aims to offer you an engaging and thought-provoking 
educational journey. The Software for Office Management course, of-
fered as an Ability Enhancement course under the Nano Entrepreneur-
ship Programme, is designed to provide hands-on training in essential 
digital tools for efficient office administration. The material covers 
key aspects of document processing and data management, ensuring 
learners gain proficiency in widely used software applications. The 
Self-Learning Material has been meticulously crafted, incorporating 
relevant examples to facilitate better comprehension. 

Rest assured, the university’s student support services will be at your 
disposal throughout your academic journey, readily available to ad-
dress any concerns or grievances you may encounter. We encourage 
you to reach out to us freely regarding any matter about your aca-
demic programme. It is our sincere wish that you achieve the utmost 
success.

Regards, 
Dr. Jagathy Raj V.P.		   			         01-01-2025
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Upon the completion of this unit, the learner will be able to;

◊	 understand the meaning and definition of office management

◊	 discuss the elements and functions of office management

◊	 comprehend the critical role of office management in business operations

◊	 identify the various filing and indexing systems and their applications in 
organisational settings

Learning Outcomes

Tom has just started his first job at a small company in Manchester. On his 
first day, he is amazed by how smoothly everything works. The office is neat, the 
computers are ready, the printer has paper, and everyone knows what they are 
supposed to do. He wonders how everything runs so perfectly.

Later, he asks his colleague, Emily, “Who makes sure everything works so well 
here?”

Emily smiles and says, “That’s all thanks to Sophie, our office manager. She is 
like the heart of the office.”

Tom looks curious, so Emily explains, “Office management is about keeping 
the workplace running smoothly. Sophie makes sure everyone has what they need 
to do their jobs well. If the printer breaks, she gets it fixed. If we are running out of 
pens or paper, she orders more. She even organises meetings and keeps the office 
nice and tidy.”

“Wow,” says Tom. “But is that all she does?”

Emily laughs. “Not even close! Sophie also plans things to make sure the office 
runs efficiently. For example, when we needed new desks, she found ones that fit 
our budget and made sure they arrived on time. And when something goes wrong, 
like a power cut or a problem with the internet, Sophie is the one who jumps in to 
fix it or find a solution.”

Prerequisite

Unit 
1 Office Management  
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1.1.1  Office Management

An office is a vital tool for management, designed to facilitate the efficient 
and economical administration of business operations. Office Management is the 
branch of management that applies core management principles to ensure tasks 
are effectively accomplished within the office setting.

The primary functions of a modern office include receiving and gathering 
information, recording and organising it, processing the data, and communicating 
it as needed.

Office management refers to the practice of planning, organising, co-ordinating 
and controlling all administrative activities within an office to ensure efficient 
operations and achieve organisational objectives.

In recent times, the term ‘Information Management’ has become more 
prevalent, reflecting a broader understanding of managing office functions. 
Additionally, terms like ‘Administrative Office Management’ and ‘Scientific 
Office Management’ are now used to emphasise the evolving role and importance 
of office responsibilities.

To make the concept relatable, let’s explore a case study.

Office Management, Filing System, Indexing, Wire or Spike Filing, Pigeonhole 
filing

Keywords

Discussion

Tom, impressed. “So she is like the team’s problem-solver?”

“Exactly!” Emily says. “She doesn’t just fix problems; she helps us stay organised, 
stay calm, and work together. Without good office management, things would be 
chaotic, and we would waste a lot of time.”

By the end of the day, Tom understands something important: office management 
isn’t just about keeping things tidy—it’s about making sure everything and everyone 
works together, like a well-oiled machine.

Office management is the secret to a happy, organised, and productive workplace! It 
keeps everything running smoothly so everyone can focus on doing their best.

In this unit, we are going to understand office management in detail.
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Case Study: Transforming the company ‘Green World Products’ through 
Office Automation

Introduction

Green World Products, a small manufacturing company specialising in eco-
friendly goods, faced significant operational challenges due to outdated manual 
processes. The company struggled with handling a large volume of paperwork 
related to invoices, inventory management, and client orders. This inefficiency 
consumed excessive time, introduced frequent errors, and slowed down decision-
making processes.

The Challenge

The lack of a streamlined office management system led to:

◊	 Delayed invoicing and payroll processing, causing cash flow issues.

◊	 Errors in inventory records, leading to stock shortages or overstocking.

◊	 Customer dissatisfaction due to mismanaged orders and communication 
delays.

◊	 Overburdened staff who spent hours searching through physical documents 
and reconciling data manually.

The Solution

Recognizing the urgent need for improvement, the management at GreenWorld 
Products decided to automate their office processes. They implemented the 
following measures:

1.	 Accounting Software (QuickBooks)

◊	 Introduced for efficient billing, payroll, and financial recordkeeping.

◊	 Automated tasks like invoice generation, payment tracking, and financial 
reporting.

2.	 CRM Tools (Customer Relationship Management)

◊	 Deployed to track customer interactions, manage orders, and ensure timely 
follow-ups.

◊	 Provided insights into customer preferences and enhanced service quality.

3.	 Document Scanning System

◊	 Used to digitize old records, reducing the dependence on physical paperwork.

◊	 Organized digital files made it easier to retrieve and share information 
quickly.
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1.1.2 Definitions of Office Management
According  to Institute of Administrative Management ,England ”office management 

is that branch of management which is concerned with the services of obtaining 
,recording and analysing information of planning and communicating ,by means of 
which the management of a business safeguards its assets, promotes its affairs and 
achieve its objectives”.

◊	 Leffing well and Robinson: “office management as a function is that branch 
of the art and science of management which is concerned with the efficient 
performances of office work, whenever and where ever that work is done.”

◊	 Littlefield and Rachel: “Office is a unit where records are prepared, handled, 
or preserved for control, planning, and efficient management.”

1.1.3 Elements of Office Management
Office management involves coordinating various elements to ensure the efficient 

and effective functioning of an office. The key elements include Personnel, Means, 
Environment, and Purpose, each playing a distinct yet interconnected role in achieving 
organisational goals. Elements of office management are like pillars of a building, if the 
pillars are strong then the building is also strong. Following are the essential elements 
of office management.

The Result

The implementation of automated systems revolutionized GreenWorld Products’ 
office management:

◊	 Time Savings: Financial reconciliation, which previously took a week, was 
now completed in just one day.

◊	 Error Reduction: Automated systems minimized human errors in financial 
records and inventory tracking.

◊	 Improved Efficiency: Staff could focus on strategic tasks rather than being 
bogged down by routine administrative work.

◊	 Enhanced Customer Satisfaction: CRM tools ensured timely communication 
and accurate order handling, leading to positive customer feedback.

Conclusion

Green World Products’ journey from a chaotic, paperwork-intensive operation 
to a digitally efficient office demonstrates the transformative power of automation 
in office management. By adopting modern tools, the company not only overcame 
its challenges but also laid a strong foundation for future growth and scalability.

This case highlights the importance of leveraging technology in office 
management to streamline operations, reduce errors, and enhance overall efficiency.
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1.	 Personnel

Personnel refers to the individuals responsible for performing office tasks and 
managing operations. They are the most critical element of office management, as their 
productivity directly impacts the office’s overall efficiency. Therefore, an organisation 
must give due care when it comes to personnel element such as;

a.	 Selection and Placement: In smaller organisations, the office manager typically 
handles recruitment and placement, while in larger organisations, this function 
is managed by the Human Resources (HR) department.

b.	 Training and Development: Office personnel must be trained to use office tools, 
follow procedures, and adopt best practices to perform their roles effectively.

c.	 Performance Management: Regular appraisals and constructive feedback help 
ensure that personnel remain motivated and aligned with the organisation’s 
objectives.

Example: In a customer service department, trained personnel equipped with 
communication skills and product knowledge can effectively resolve customer queries, 
improving customer satisfaction.

2.	 Means

Means refers to the tools, equipment, and resources required to perform office 
tasks efficiently. This includes physical items such as stationery, computers, and office 
equipment, as well as digital tools like software and communication platforms. The 
following aspects to be noted.

a.	 Provision of Resources: Ensuring that all necessary tools are available for office 
operations.

b.	 Efficient Utilization: Proper use and maintenance of tools to optimise productivity 
and minimise wastage.

Example: A marketing team equipped with updated design software and high-speed 
internet can create and execute campaigns faster and more effectively.

3.	 Environment

The office environment encompasses the physical and organisational conditions in 
which personnel work. A positive and well-organized environment enhances employee 
morale, productivity, and overall operational efficiency. It includes:

a.	 Physical Environment: Includes lighting, ventilation, ergonomic furniture, and 
cleanliness. A comfortable and healthy workspace reduces fatigue and promotes 
focus.

b.	 Organizational Culture: A supportive and collaborative culture encourages 
teamwork and innovation.

c.	 Adaptation to Business Nature: The office setup should align with the specific 
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needs of the business, such as a creative atmosphere for an advertising agency 
or a highly organised environment for a legal firm.

Example: A tech company with an open-plan office, recreational spaces, and flexible 
working hours fosters innovation and collaboration among its employees.

4.	 Purpose

Purpose refers to aligning individual tasks with the organisation’s overall objectives. 
It ensures that all activities contribute meaningfully to achieving the organisation’s 
goals. It consists:

a.	 Clarity of Purpose: Employees should clearly understand how their tasks 
contribute to organizational success.

b.	 Communication by Office Manager: The office manager plays a critical role 
in explaining the purpose of tasks and ensuring that employees remain goal-
oriented.

Example: In a sales department, understanding that their role directly impacts revenue 
generation motivates team members to focus on lead conversion and customer 
engagement.

The elements of office management—personnel, Means, Environment, and 
Purpose—work together to create a productive and goal-oriented office. By effectively 
managing these elements, an organisation can optimise its operations, enhance employee 
satisfaction, and achieve its objectives. Each element requires ongoing attention and 
alignment with the changing needs of the organisation and its workforce.

1.1.4 Functions of Office Management
Office management plays a vital role in an organisation’s efficient functioning by 

overseeing essential basic and administrative functions. These functions ensure that 
information is handled systematically, and resources are managed effectively to achieve 
organisational goals.

1.1.4.1 Basic Functions
a.	 Information Collection: Information collection is a fundamental function of 

office management, as it forms the basis for decision-making and planning. This 
involves gathering data from both internal sources, such as employee reports 
and departmental updates, and external sources, like customer feedback, market 
surveys, and supplier communications. 

For example, a retail company might collect sales data and customer feedback through 
surveys to identify purchasing trends and preferences. Similarly, invoices and purchase 
orders from suppliers provide essential information for inventory management.

b.	 Information Recording: Once collected, information must be documented in 
an organised and accessible format. Office management ensures this is done 
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through reports, charts, registers, or digital systems. 

For instance, a logistics company might record shipment details in a centralised 
database to track deliveries and monitor performance. By maintaining well-organized 
records, the office provides a reliable source of information for reference and audit 
purposes.

c.	 Information Processing: Raw data is often not immediately useful and needs 
to be processed into actionable insights. Office management plays a key role in 
analysing, organising, and structuring this information. 

For example, a financial team might analyse revenue data to prepare profit and 
loss statements, while a marketing team might use customer demographics to develop 
targeted advertising strategies. This step transforms scattered data into valuable inputs 
for informed decision-making.

d.	 Information Preservation: Preserving information ensures that records are 
available for future reference and use. Office management employs systematic 
filing methods, both physical and digital, to safeguard these documents. 

For instance, a legal firm might store client agreements and case histories in secure 
digital archives to ensure compliance and easy retrieval. Preservation not only supports 
current operations but also helps organisations maintain a comprehensive record of 
their activities.

e.	 Information Dissemination: Processed information is of little value unless it is 
effectively communicated to relevant stakeholders. Office management ensures 
that data flows smoothly to those who need it, whether employees, managers, 
or external parties. 

For example, a project manager might distribute weekly progress reports to the 
leadership team to keep them informed and facilitate timely decision-making. Similarly, 
customer service teams rely on accurate data to resolve queries effectively.

1.1.4.2 Administrative Functions
a.	 Management Functions: Office management encompasses core management 

functions such as planning, organising, staffing, directing, and controlling office 
activities. 

For instance, planning involves creating employee schedules to meet project 
deadlines, while organising ensures that resources are allocated efficiently. Staffing 
focuses on recruiting skilled personnel, and directing involves guiding teams to achieve 
their objectives. Controlling and monitoring operations to ensure that all activities align 
with the organisation’s goals.

b.	 Procurement and Maintenance: The office manager is responsible for 
procuring essential tools, equipment, and supplies and ensuring their upkeep. 
This includes items like stationery, furniture, computers, and software. 
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For example, an IT company might procure new laptops for its developers and 
regularly update software licenses to maintain operational efficiency. Ensuring timely 
maintenance prevents disruptions and enhances productivity.

c.	 Personnel Management: Managing office personnel involves recruiting, 
training, and ensuring their overall well-being. 

For example, a customer service department might train employees on new 
CRM software to improve their efficiency in handling client interactions. Personnel 
management also includes conducting performance evaluations, providing feedback, 
and implementing employee welfare programs, such as health benefits or professional 
development opportunities.

d.	 Public Relations: Another critical administrative function is maintaining 
a positive image of the organisation. This involves handling customer 
inquiries, managing complaints, and fostering good relationships with external 
stakeholders. For instance, a company launching a new product might use press 
releases and social media campaigns to build awareness and engage with the 
public. Resolving customer grievances promptly and professionally is equally 
important to uphold the organisation’s reputation.

e.	 Asset Safeguarding: Protecting physical and digital assets is crucial for 
any organisation’s long-term sustainability. Office management ensures that 
physical assets, such as office premises and equipment, are secured through 
measures like surveillance systems and regular audits. Digital assets, such as 
customer data and financial records, are protected using firewalls, backups, and 
secure access controls. 

For instance, a healthcare organisation might implement robust cybersecurity 
measures to safeguard sensitive patient information.

The functions of office management—spanning both basic and administrative 
responsibilities—are integral to an organisation’s efficient and effective operation. By 
systematically collecting, processing, and disseminating information while managing 
resources and personnel, office management ensures that all activities align with the 
organisation’s objectives. Real-world examples illustrate how these functions play out 
in various industries, highlighting their universal importance in driving organisational 
success.

1.1.5  Objectives of office management
An office is an important part of any organisation, which controls the activities of the 

organisation . Proper efficient and effective office management is vital for the smooth 
functioning of any organisation. The definitions which we have discussed in 1.1.2 above 
indicate that aim of the office management is the organisation of an office and this office 
organisation helps in achieving specific office objectives.
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                      Figure 1.1.1  Objectives Of Office Management

1.1.5.1  Achievement of organisational Goals

Every organisation will have specific goals and objectives. They will have short, 
medium and long term objectives. All the departments/functional areas of the 
organization derive their departmental objectives from the long term objectives of the 
organisation. Efficient office management helps in achieving the departmental as well 
as organisational goals without any difficulty.

1.1.5.2  Optimum utilization of resources.

Optimum utilization of human and material resources is one of the major objective 
of office management. It means achieving both efficiency and effectiveness. It involves 
doing things right as well as doing right things.
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1.1.5.3  Smooth operational work flow

Another objective of office management to achieve smooth work flow through 
supervising the administrative staff ,to ensure that they are performing the allotted 
duties in a proper manner. Standard office procedures, clear cut policies, procedures 
and rules will help to achieve smooth work flow. Regular training and development of 
administrative staff can improve operational work flow. This not only enhances their 
performance but also boosts their career growth.

1.1.5.4  Facilitating Effective communication

Communication is the life blood of any organisation. Effective flow of communication 
is yet another objective of office management. Communication channels should ensure 
fast and timely flow of accurate and relevant information. Creating open channels for 
communication, such as team meetings and feedback sessions helps in keeping every 
one informed and it fosters a culture of transparency and trust.

1.1.5.5  Effective co-ordination of diverse activities

Lot of activities are performed in the office, coordinating these diverse administrative 
operations are must for smooth operational office flow in office. Office management 
ensures that there are no inter and intra team conflicts. Effective office management 
ensures that these activities are well coordinated. coordinating activities between 
different departments ensures that every one is working towards common goals.

1.1.5.6  Development of Human resources

Development of human resources in the office is another important as well as crucial 
aspect in office management, as they are the only thinking resource and greatly influence 
the utilization of other resources wisely and effectively. Office management focuses on 
the development of human resources to ensure that the work force is skilled, motivated 
and efficient.

1.1.5.7  Maintaining good relations with customers and suppliers

Maintaining good relationships with customers and suppliers are crucial for the 
success of any organisation. Office management plays a key role in maintaining good 
relations with both customers and suppliers. Providing excellent customer service helps 
in building long term relationship with clients. This involves quick solving of issues 
with customers and suppliers efficiently, thereby ensuring customer satisfaction. Good 
relationship with suppliers help in getting raw materials at better price and uninterrupted 
supply.

1.1.5.8  Creating a better office environment

A positive office environment will boost morale of employees ,enhance productivity 
.Ensuring a safe working environment is important for the reputation and good will to 
any organisation to attract employees towards the organisation. This involves complying 
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to safety standards and regulations and providing necessary safety equipment. It helps 
in ascertaining  that the company vehicles are properly maintained and are in working 
condition and having proper legal documents.

Effective office management is important for the success of any organisation the 
backbone of any successful organisation lies in effective office management. For 
ensuring that operations flow seamlessly to fostering a positive work environment, 
office management  covers a spectrum of objectives that are crucial for achieving 
organizational goals which we have discussed above.

1.1.6  Filing of documents
Filing is a structured process of systematically storing and organising documents 

to ensure easy retrieval, protection, and management. It is an essential administrative 
function in any organisation, helping to maintain order and ensure that important 
records are readily available when needed. Whether for legal, financial, or operational 
purposes, a proper filing system enhances efficiency and prevents data loss.

For example, consider a hospital where patient records are stored. A well-maintained 
filing system ensures that doctors and administrative staff can quickly retrieve a patient’s 
medical history, avoiding delays in treatment. Similarly, in a legal firm, client case files 
must be organised so that attorneys can locate them promptly for court proceedings.

So, Filing is the process of classifying, arranging and storing records so that they can 
be located when required. It is also the process of collecting and arranging records or 
their copies in such a way so that whenever it is needed, it can be found very easily. All 
offices receive letters and dispatches that are kept for future use. They are to be stored in 
a safe place. For that, filing is required. It is an important part of management that helps 
to decide about anything in a legal and systematic way. It is the process of arranging 
and protecting records so that they may be found and delivered easily when needed in 
the future. 

1.1.6.1  Objectives/Purpose of Filing
i.	 Document collection: The first purpose of filing is to collect documents from 

internal and external sources. Such documents are required for future reference 
and should be collected in one place.

ii.	 Systematic arrangement of records: Documents collected from various sources 
need to be classified and grouped according to their nature and properties. The 
filing department arranges records in a systematic manner for future reference.

iii.	 Evidential purpose: Some records are kept for proof purposes. The filing 
department preserves some records so that they can be presented as proof in a 
dispute between two parties.

iv.	 Quick and easy retrieval: Systematic filing helps locate records easily whenever 
required. Quickly obtaining records assists in quick decisions, boosting the 
prestige of the office.
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v.	 Guiding purpose: Many plans are formulated based on past records, which are 
available in the filing department. So, filing is kept to guide planning.

vi.	 Efficiency: Filing provides the required documents and information at the right 
time. It prevents time and energy from being wasted searching for documents. 
Therefore, it increases the efficiency of staff.

vii.	 Guideline for planning and control: Filing makes past and present records 
available to management. Based on those records, management formulates 
future plans. Management also evaluates enterprise activities and takes 
corrective action based on the filing system.

viii.	Legal formalities: Filing fulfils various legal obligations of an organisation as 
it maintains records as prescribed by law.

ix.	 Increase goodwill: As filing facilitates quick and efficient performance, it 
contributes to increasing the goodwill of the organisation.

x.	 Evidential proof: Filing is important to settle bilateral disputes. The records 
can be presented as proof so that misunderstandings can be minimised 

1.1.6.2  Types of Filing

                  

    

                                                 

                                                    
                                                     Figure  1.1.2

A.	 Traditional Filing Systems

A traditional filing system is a method of storing and organising documents that was 
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commonly used in the early days of office management. It relies on simple, manual 
techniques and basic equipment to arrange papers. Traditional systems are typically 
inexpensive and straightforward but lack the efficiency and sophistication of modern 
methods. These systems are still useful for small businesses with limited documentation 
needs.

Key Features

1.	 Manual Organisation: Documents are sorted and stored by hand without the 
use of advanced equipment.

2.	 Basic Tools: Includes items like wires, cardboard, or wooden cabinets.

3.	 Limited Capacity: Designed for a smaller volume of documents.

4.	 Simplicity: Easy to set up and understand, making it accessible to all staff.

5.	 Cost-Effective: Requires minimal investment in equipment or storage.

Following are some of the traditional filing systems.

1.	 Wire or Spike Filing

The wire or spike filing system is one of the simplest and oldest filing methods. It 
involves a long steel rod, about one foot long, with a hook at the top and a stopper at 
the bottom. Documents, such as receipts or temporary papers, are pierced and threaded 
onto the spike in chronological order. The spike is either mounted on a wall or placed 
upright on a desk. This method is mainly used for short-term record-keeping since 
documents are exposed to dust, water, and potential damage.

Example: A small bakery might use a spike filing system to hold customer bills for the 
day. At the end of the day, they clear the spike and transfer important documents to a 
more permanent storage solution.

                 

          
                                        Figure 1.1.3 Wire Or Spike Filing
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2.	 Pigeonhole Filing

This system’s name originates from its resemblance to traditional pigeon coops, 
where pigeons return to their assigned “holes.”

The pigeonhole filing system involves a cabinet or almirah divided into small 
compartments resembling pigeon nests. Each compartment is labelled alphabetically, 
numerically, or by department, allowing documents to be sorted and stored accordingly. 
This method is simple and helps in organising daily correspondence or documents 
related to specific categories. For example, letters addressed to different departments 
can be placed in their respective compartments for easy distribution.

Example: A small accounting office might have pigeonholes labelled for each client, 
where incoming invoices and statements are placed.

                       
                                       
                                        Figure 1.1.4  Pigeonhole Filing

3.	 Cardboard Filing

This method uses sturdy cardboard sheets as covers, with documents placed between 
them. The papers are secured by tying the cardboard with lace or thread. Each cardboard 
file is labelled for identification and stored in an almirah or on shelves. This method is 
suitable for small-scale operations where storage needs are limited. It’s compact and 
inexpensive but lacks advanced indexing, making document retrieval time-consuming.

Example: A small bookshop might store invoices or supplier orders in cardboard files 
for monthly bookkeeping.SG
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                                        Figure 1.1.5 Cardboard Filing

4.	 Box Filing

In box filing, documents are stored in box-shaped containers with spring clips to hold 
papers in place. The boxes, often made of sturdy material, can be labelled by subject, 
date, or category. Documents are usually stored chronologically for easy retrieval. This 
system provides better protection for documents compared to spike or pigeon hole filing 
and is suitable for small businesses.

Example: A tuition centre might store student records in separate box files based on the 
year of enrolment.

                 

                                               Figure 1.1.6 Box Filing

5.	 Press Copy Book Method

In this method, copies of all outgoing letters are maintained in a large book. This 
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is achieved by using carbon paper or manually transcribing the letters into the book. 
These records are kept for reference or legal purposes. While the system provides a 
clear record of dispatched correspondence, it is time-consuming and impractical for 
large organisations.

Example: An early 20th-century legal office might use this method to record letters 
sent to clients and courts.

B.	 Modern Filing Systems

Modern filing systems are advanced methods of organising, storing, and retrieving 
documents efficiently in contemporary office environments. These systems are designed 
to handle large volumes of records while ensuring security, accessibility, and ease of 
use. They incorporate structured techniques, durable equipment, and often technology 
to streamline record-keeping.

Key Features

1.	 Advanced Equipment: Uses cabinets, suspension files, folders, and other 
durable materials.

2.	 Efficient Organisation: Designed to categorise documents systematically, 
often with indexing systems.

3.	 Space-saving: Compact and organised to maximise office space.

4.	 Quick Retrieval: Allows users to locate specific documents easily with 
labelling, indexing, and proper categorisation.

5.	 Adaptability: Can handle different types of documents and scales with the 
organisation’s needs.

These methods are efficient, durable, and suitable for the high-volume needs of 
modern businesses.

1.	 Horizontal Filing

Horizontal filing involves storing documents flat, stacked one on top of the other, 
in drawers or shelves. Each folder or file is labelled, and documents are stored 
chronologically. This system works well for large-format documents like blueprints 
or maps but may become cumbersome if files aren’t regularly sorted. While horizontal 

Press copy books were widely used before the invention of photocopy 
machines as a method to preserve correspondence. These books allowed offices 
to keep a copy of outgoing letters by using carbon paper or pressing inked letters 
onto thin paper for duplication. This historical method was an essential tool 
for record-keeping, particularly in legal and administrative settings. It reflects 
the ingenuity of earlier office systems before the advent of modern duplication 
technologies.
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filing protects documents from bending, its inefficiency in retrieval has led to the rise 
of vertical systems.

Example: An architecture firm might use horizontal filing to store design plans and 
building layouts.

                     

                                           Figure 1.1.7 Horizontal Filing

2.	 Vertical Filing

This method involves storing files upright in cabinets or drawers. Folders are used 
to group documents, and tabs are added for easy identification. This system is widely 
used in modern offices because it saves space and facilitates quick document retrieval. 
Vertical filing cabinets can hold more documents in less space than horizontal drawers, 
making them a staple in offices worldwide.

Example: A legal firm might organise case files by client name or case number in 
vertical cabinets.

                             

                                         Figure 1.1.8 Vertical Filing
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3.	 Suspension Filing

Suspension files are folders hung on metal rails inside drawers. The rails allow the 
files to slide easily, making document retrieval smooth. Tabs or labels on the folders 
enhance organisation. This system reduces document wear and tear, as files don’t have 
to be shuffled or stacked.

Example: An HR department might use suspension filing to store employee records 
alphabetically.

                      
                                

                                  Figure 1.1.9 Suspension Filing
4.	 Lateral Filing

Files are stored side by side on wide shelves or drawers, often with visible labels. 
This system is similar to vertical filing but more space-efficient for storing a large 
number of documents.
Example: A public library might use lateral filing for categorised archival records.
                                                      

  Table 1.1.1
            Difference between Vertical, Suspension and Lateral Filing

Aspect Vertical 
Filing

Suspension 
Filing

Lateral 
Filing

File 
Orientation

Upright, 
front-to-back

Hanging upright 
on rails

Side-by-side, 
labels visible

Access
May require 
digging

Easy due to 
the sliding 
mechanism

Quick due to 
visible labels

Space 
Efficiency Moderate High Very high
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                                                  Table 1.1.2
 Comparison between Traditional  and Modern Filing Systems  
Aspect Traditional Filing Modern Filing
Efficiency Low High

Capacity Limited High
Security Minimal Enhanced
Adaptability Fixed methods Flexible to different needs
Technology Use None Can incorporate digital tools

1.1.6.3  Methods of Filing Systems
Filing systems are designed to organise and store records in a way that simplifies 

retrieval and ensures efficiency. These systems can vary depending on the nature of the 
organisation and the type of documents being managed. Below are the different types 
of filing systems, with added details and examples:

1.	 Manual Filing Systems

Manual filing systems involve physical storage and organisation of paper records. 
They are suitable for organisations with moderate record volumes and limited need for 
advanced technology.

i.	 Alphabetical Filing: Records are organised by name, such as people, businesses, 
or institutions. For example, in a school, student records may be arranged 
alphabetically by last name to simplify access during registration or audits.

ii.	 Numeric Filing: Records are arranged using assigned numbers, such as account 
numbers, invoice numbers, or employee IDs. Hospitals often use numeric filing, 
assigning unique patient numbers to facilitate the retrieval of medical records.

iii.	 Alphanumeric Filing: A combination of numbers and subjects is used for 
organising records. For instance, a company might categorise its files with codes 
such as “HR001” for employee records and “FIN2023” for financial reports 
from 2023. This system combines the benefits of subject and numeric filing for 
more detailed organisation.

iv.	 Subject Filing: Documents are categorised by subject or category. For example, 
a library may organise its books into categories such as history, science, and 
fiction, each with subcategories for more precise classification.

v.	 Geographical Filing: Records are arranged based on location, such as countries, 
cities, or regions. For instance, a multinational company might file its sales 
reports by country, with subfolders for specific regions or states.

vi.	 Chronological Filing: Records are organised by date, making it easier to track 
documents over time. A project management team, for example, might file 
progress reports or meeting minutes chronologically to maintain a clear timeline 
of activities.
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vii.	 Loose-leaf Filing: Individual pages are stored in a binder or folder, allowing for 
easy updates and reorganisation. For example, an HR department may maintain 
employee handbooks or policies in loose-leaf binders so that they can replace 
outdated pages with new versions as needed.

2.	 Digital Filing Systems

In the age of paperless offices, we need to convert all the physical records to electronic 
data that eventually rests on a variety of offline and online networks. Most businesses& 
government offices have already shifted to paperless office, or close to it .With online 
cloud -based storage systems, and digital transactions replacing cash, paperless is the 
new normal.  Digital filing systems use computer-based tools and software to store 
and organise electronic records. These systems are particularly useful for organisations 
handling large volumes of data and requiring advanced search functionalities.

i.	 Cloud Storage: Records are stored on cloud-based platforms like Google Drive, 
Dropbox, or OneDrive. For example, a marketing agency may use cloud storage 
to share campaign files with team members across different locations, enabling 
real-time collaboration.

ii.	 Database Management Systems (DBMS): Organizations use software to store 
and retrieve data systematically. For instance, an e-commerce company might 
use a DBMS to organise customer orders, product inventories, and shipping 
details.

iii.	 Hybrid Filing Systems: To accommodate both physical and electronic records, 
a combination of manual and digital filing methods is used. For example, a legal 
firm might keep original signed contracts in physical files while maintaining 
digital copies in a cloud-based repository.

By incorporating the different types of filing systems, organisations can choose 
the approach that best suits their needs, whether for physical or electronic records or 
small-scale or large-scale operations. Each method, such as alphabetical, numeric, or 
loose-leaf filing, has its unique advantages and applications, ensuring that records are 
managed efficiently and retrieved easily when needed.

1.1.7  Indexing Documents
Indexing, in the context of filing, is a tool or system that helps to locate files or 

records quickly and efficiently. It acts as a guide that points to the exact location of 
documents within a filing system. Proper indexing is crucial, especially when managing 
a large number of files, as it ensures easy retrieval and systematic organisation.

An indexing is defined as “anything that points out or indicates.” It simplifies the 
process of determining where specific documents are stored, saving time and improving 
office efficiency.

1.1.7.1  Meaning of Indexing

Document indexing is the process of associating or tagging documents with different 
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search terms. Indexing helps in the speedy identification of records and archives in the 
documenting arrangement of the work place. It is not only essential to big offices but 
also needed to small offices. When a large number of documents are to be maintained, 
the necessity of maintaining an index is enlarged.

1.1.7.2  Types of Indexing

1.	 Page Index

The page index is one of the simplest forms of indexing. It involves an alphabetical 
or numerical list where each letter or number corresponds to a specific page in the 
index book. Within each page, entries are listed systematically based on their category, 
subject, or relevant detail. This type of indexing is easy to use and often found in bound 
books or ledgers.

Example: Imagine a hospital using a page index to maintain patient records. Each page 
is assigned a letter, and under “A,” all patients whose names start with “A” are listed, 
along with their record numbers.

This method is straightforward and inexpensive, making it ideal for small-scale 
record-keeping. It can become cumbersome when dealing with a large volume of 
records, as searching through lengthy lists can take time.

2.	 Bound Book Index

This method maintains an index in a bound book. Each entry is recorded manually, 
and the book serves as a permanent reference. This system is particularly useful for 
organisations requiring a durable and tamper-proof record of entries.

Example: A legal office may use a bound book index to record case files, with each 
entry including the case name, date, and file location.

It ensures records are preserved in a secure format, and the risk of pages being lost 
is minimal. Since it is bound, pages cannot be added or updated easily, making it less 
flexible than loose-leaf systems.

3.	 Loose Leaf Index

The loose-leaf index consists of individual sheets of paper kept in a binder or folder. 
Entries are made on these sheets, and the flexibility of adding, removing, or replacing 
sheets makes this method highly adaptable. This type of indexing is particularly suitable 
for dynamic records that require frequent updates.

Example: A marketing agency might use a loose leaf index to track campaign details. 
If a campaign concludes, its sheet can be replaced with a new one for an upcoming 
project.

This system is highly flexible and allows for easy updates. Loose sheets can be 
misplaced or damaged if not handled carefully.
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4.	 Vowel Index

The vowel index refines alphabetical indexing by considering vowels in the second 
or subsequent positions of words. It reduces the time spent searching for specific records 
by creating subcategories under each alphabetical heading.

Example: In a library, books might be organised under “B” for titles like “Batman,” 
“Beginner’s Guide,” and “Biology.” Subcategories like “Ba,” “Be,” and “Bi” ensure 
quicker access to the exact book.

It is more specific than a simple alphabetical index and saves time in locating items. 
Requires careful planning and maintenance to avoid miscategorisation.

5.	 Vertical Card Index

This system uses small cards stored vertically in trays or boxes. Each card represents 
a record, containing details such as a subject name, reference number, or location. The 
cards are organised alphabetically, numerically, or by category.

Example: A school might use a vertical card index to keep track of student information. 
Each card contains the student’s name, roll number, and contact details, stored 
alphabetically for quick retrieval.

The system is compact, space-efficient, and easy to rearrange or update. Cards can 
be misplaced or damaged if not stored securely.

6.	 Visible Card Index

The visible card index involves placing cards in transparent sleeves or trays, where 
only the essential information, such as titles or headings, is visible. This system allows 
users to view multiple entries simultaneously without removing the cards from their 
holders.

Example: A travel agency might use a visible card index to display popular tour 
packages. Each card shows the destination, duration, and cost, making it easy for 
customers to browse.

It saves time by allowing quick reference without handling the cards. Limited storage 
capacity, as only essential information is displayed.

7.	 Strip Index

The strip index involves placing information on narrow strips, which are arranged 
in a frame or tray. This system is commonly used for directories or frequently accessed 
lists, such as contact information or schedules.

Example: A corporate office might use a strip index to display a directory of employees, 
with each strip showing the employee’s name, department, and contact number.

Compact and ideal for quick reference of frequently used information. It may not be 
suitable for large-scale record-keeping due to limited space on the strips.
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◊	 Meaning: Office management refers to the art of planning, organising, and 
supervising the day-to-day activities within an office to ensure the efficient 
operation of an organisation. It involves managing administrative functions, 
information flow, and office resources.

◊	 Key Functions: Collecting, recording, processing, and disseminating 
information effectively for decision-making.

◊	 Elements of Office Management: Focus on personnel, means, environment, 
and purpose to optimise operations.

◊	 Importance of Filing: Organises and safeguards records for quick retrieval 
and legal compliance.

◊	 Traditional Filing: Includes manual systems like spike filing and pigeonhole 
filing for small-scale use.

◊	 Modern Filing: Utilises advanced systems like vertical and lateral filing for 
efficiency and scalability.

◊	 Indexing Systems: Facilitates document location through page, card, strip, 
and vowel-based methods.

Recap

1.	 What is the purpose of office management?

2.	 Name one element of office management.

3.	 What is filing?

4.	 What does CRM stand for?

5.	 What is the oldest filing method?

6.	 Which filing system uses hanging folders on rails?

7.	 What is a page index?

8.	 What type of filing stores documents side by side?

9.	 Which element of office management includes tools and equipment?

10.	 Which indexing method uses vowels for categorisation?

Objective Questions
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11.	 What is the primary goal of indexing?

12.	 What is centralised filing?

1.	 Efficient administration of office activities.

2.	 Personnel.

3.	 Systematic storage of documents.

4.	 Customer Relationship Management.

5.	 Wire or spike filing.

6.	 Suspension filing.

7.	 Alphabetical guide in a book.

8.	 Lateral filing.

9.	 Means.

10.	 Vowel index.

11.	 Quick retrieval of documents.

12.	 All records are stored in one location.

Answers

1.	 Explain the importance of office management in modern organisations.

2.	 Describe the advantages and disadvantages of traditional filing systems.

3.	 Discuss the role of automation in office management with a relevant 
example.

4.	 Differentiate between vertical, suspension, and lateral filing systems.

5.	 Elaborate on the key elements of office management and their 
interdependence.

Assignments
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After the completion of this unit, the learner will be able to;

◊	 understand the basic functionalities and features of Google Forms, including 
form creation and customisation

◊	 analyse the integration of Google Forms with other Google tools like Sheets 
and Drive for efficient data handling

◊	 explore practical applications of Google Forms in education, business, event 
management, and personal use

◊	 develop skills to design, share, and analyse responses from Google Forms 
effectively

Learning Outcomes

Imagine your class is organising a farewell party for final-year students. The 
organising committee needs to gather preferences from students about the event, 
such as:

◊	 Menu preferences (vegetarian/non-vegetarian).

◊	 Suggestions for the event theme.

◊	 Availability on specific dates.

Instead of collecting this information manually (which can be time-consuming 
and chaotic), Google Forms makes this process simple, efficient and organised.

In this unit, we will learn how to create Google Forms along with its application.

Prerequisite

Unit 
2 Google Forms 

Google Workspace, Google Form, Google Sheets, Form Limiter, Multiple 
Choice,  Eye Icon

KeywordsS
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 1.2.1 Google Form
Google Forms is an online application developed by Google that allows users to 

create and distribute forms, surveys, quizzes, and polls easily. It is part of ‘Google 
Workspace’ (formerly G Suite) and is widely used across educational, professional, 
and personal domains. This versatile tool is free to use, integrates seamlessly with 
other Google apps, and enables efficient data collection and analysis.

1.2.1.1 Features of Google Form

1.	 Customisable Form Creation: One of the standout features of Google 
Forms is its customisability. Users can create forms tailored to their specific 
needs by using a variety of question types, including short answer, paragraph, 
multiple choice, checkboxes, dropdowns, and file uploads. For more detailed 
inputs, linear scales and multiple-choice grids are also available. To make 
forms visually appealing and interactive, users can add images, videos, and 
section breaks. These features make it possible to design anything from 
simple feedback forms to complex surveys and quizzes, accommodating a 
wide range of scenarios.

2.	 Integration with Google Tools: Google Forms is designed to work 
seamlessly with other Google tools, especially Google Sheets and Google 
Drive. When a form is created, its responses can be automatically stored and 
organised in a Google Sheet, allowing users to perform in-depth analysis 
with filters, formulas, and charts. The forms themselves are stored in Google 
Drive, ensuring easy access and secure storage. This integration eliminates 
the need for manual data transfer, reducing errors and saving time.

3.	 Pre-Designed Templates: To simplify the process of form creation, Google 
Forms offers a collection of pre-designed templates. These templates are 
designed for specific purposes such as event registrations, customer feedback, 
job applications, and more. By starting with a template, users save time and 
effort while ensuring their form has a professional and functional structure. 
For instance, an event organiser can use the event registration template to 
quickly collect attendees information and preferences.

4.	 Real-Time Collaboration: Google Forms supports real-time collaboration, 
enabling multiple users to work on the same form simultaneously. Changes 
made by one user are instantly visible to others, ensuring everyone is working 
on the most up-to-date version. This feature is especially useful for team 
projects, allowing members to contribute their ideas and insights during 

Discussion
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form creation. For example, in a marketing team, one person might design the 
questions while another adjusts the layout or settings.

5.	 Response Collection and Management: Google Forms makes collecting 
and managing responses effortless. As respondents submit their entries, the 
data is automatically collated and summarised within the platform. Users can 
view individual responses or overall summaries, which are presented as charts 
and graphs for quick insights. For further analysis, the data can be exported 
to a Google Sheet or downloaded as a CSV file. Users also have control over 
response settings, such as limiting submissions to one per person or enabling 
anonymous responses.

6.	 Accessibility and Sharing Options: Forms created in Google Forms are easy to 
share, making them accessible to a wide audience. They can be shared through a 
link, embedded on a website, or sent via email. Users can control who accesses 
the form by restricting it to specific individuals, domains, or making it public. 
Additionally, the mobile-friendly design ensures that respondents can easily fill 
out forms on any device, whether it’s a smartphone, tablet, or computer.

7.	 Add-Ons and Extensions: To enhance functionality, Google Forms supports 
a variety of add-ons and extensions. For example, the Form Limiter add-on 
allows users to set submission limits or deadlines, while Certified can generate 
certificates for respondents who complete a quiz or survey. These add-ons 
enable users to customise forms for specific requirements and improve overall 
efficiency. By incorporating these tools, businesses and educators can streamline 
workflows and achieve better outcomes.

1.2.1.2 Applications of Google Forms

1.	 Education: Google Forms has become a favourite tool for educators. Teachers 
use it to create quizzes, collect assignments, and track attendance. The automatic 
grading feature for quizzes saves significant time, while feedback forms provide 
valuable insights into student needs. Schools can also utilise forms for parent 
surveys, event sign-ups, or gathering alumni data.

2.	 Business: In the corporate world, Google Forms is used for various purposes, 
including market research surveys, employee satisfaction surveys, and data 
collection. For example, HR departments use it for onboarding processes, 
collecting employee details, or managing exit interviews. Additionally, 
companies use forms to gather customer feedback, which helps improve 
products and services.

3.	 Event Management: Event organisers can use Google Forms to simplify 
planning and execution. By creating an event registration form, organisers 
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can collect RSVPs, dietary restrictions, and other preferences from attendees. 
After the event, feedback forms help evaluate the event’s success and gather 
suggestions for improvement.

4.	 Personal Use: Google Forms is not just for professionals—it’s also useful for 
personal tasks. Individuals can use forms to plan family reunions, organise 
birthday parties, or conduct polls for gift exchanges. Its simplicity makes it a 
go-to tool for managing personal projects.

1.2.1.3  How to Create Google Form?

The simplest way to create a Google Form is directly from the Google Forms web 
app. 

Step 1: Access Google Forms

1.	 Go to Google Forms:

◊	 Open your web browser and go to Google Forms. Or docs.google.com/forms.

◊	 Alternatively, from your Google Drive, click + New > More > Google Forms.

                                                      Figure 1.2.1

Step 2: Start a New Form

1.	 Blank Form:

◊	 Click the Blank (‘+’ symbol) form to start fresh.

2.	 Template Gallery:

◊	 If you prefer, choose from pre-designed templates in the Template Gallery.SG
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                                                          Figure 1.2.2

Step 3: Add Questions and Customize

1.	 Title and Description:

◊	 At the top, add a title and description for your form to let users know its purpose.

◊	 Add valid E-mail ID

                                                     Figure 1.2.3

2.	 Add Questions:

◊	 Click the + button on the right to add a new question.

◊	 Choose a question type (e.g., multiple choice, dropdown, short answer, etc.).
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                                                    Figure 1.2.4

To add more questions, click the Add question icon, which looks like a plus sign (+), 
in the floating toolbar next to your question box. And to modify the question type, click 
the dropdown next to the question field.

3.	 Customise Questions:

◊	 Type the question and provide possible answers (if applicable).

◊	 Toggle Required if the question must be answered.

              

  

                                                     Figure 1.2.5

Google Forms offers eleven different question types. Here’s what each one does: 

◊	 Short answer: This field is perfect for asking for small bits of text like names, 
email addresses, and values. You get one line of text to answer the question—
though your users could actually enter as much text as they want.

◊	 Paragraph: This field is for long-form text. Use it when you want detailed 
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feedback or longer notes in the answer.

◊	 Multiple choice: This is the default field for new questions in a Google Form. It 
lets you list different options and have users select only one. You can then have 
the form jump to another section based on the answer or have the answer options 
shuffled to prevent bias.

◊	 Checkboxes: This field lets you list different options and have users select as 
many as they want. It also includes data validation to require users to select a 
specific number of options. It doesn’t include section jumps, however.

◊	 Dropdown: This is similar to the multiple choice question type with the same 
section jump and shuffle options. The only difference is that the answers are 
presented in a dropdown menu. This is useful for keeping your form compact 
when there are many answer options.

◊	 File upload: This isn’t a question type by itself, but it lets your respondents 
upload files that will automatically save in your Drive. If you use this, be sure 
to share your form only with people you trust. 

◊	 Linear scale: This field lets respondents select a number in a range, so you can 
set a numerical scale starting at 0 or 1 and ending anywhere from 2 to 10. You 
can also add labels for the lowest and highest options. And yes, emoji work for 
labels, too.

◊	 Multiple choice grid: This is perhaps the most confusing field, as the fields 
are displayed in a list rather than in a grid. Essentially, you enter questions as 
rows and answers as columns. You can include as many rows and columns as 
you want, but note that respondents will have to scroll right to see more than six 
columns on desktop browsers or just three columns on mobile. In addition to the 
standard option to require a response for each question, the multiple choice grid 
lets you limit users to only one response per column.

     

                                                            Figure 1.2.6

◊	 Checkbox grid: This is set up similarly to the multiple choice grid, but 
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respondents can select multiple answer options (columns) for each row in a 
table. It’s a good option to let respondents make comparisons or select, say, their 
levels of satisfaction with a product. You can limit users to choosing just one 
answer per row, and you can also shuffle the row order to eliminate bias. 

◊	 Date: This field is useful if you want to ask for a specific date, perhaps to schedule 
an event or log an activity. Note: the date format will appear in the default format 
for your location. For example, if your account’s preferred language is set to US 
English, dates will be formatted as MM/DD/YYYY; UK English accounts, on 
the other hand, will show dates as DD/MM/YYYY. Your users will see the date 
options in your location’s date format unless they’re logged in to their Google 
Account.

◊	 Time: This field lets respondents enter time in hours and minutes.

All question types allow you to insert an image, but if you want to add only an image 
or video with no question, you can do that, too. Click the Add image or Add video icon 
in the floating toolbar, and choose the image or video you want to insert.

        

                                                         Figure 1.2.7

Note: Google Forms supports only YouTube videos, which you can add through search 
or with a link. 

Whether you’ve added images or videos, your entry will have the standard title and 
description fields, along with options to resize and show the video or image center-, 
left-, or right-aligned.

Accidentally remove a form element or add one too many?
 Press command + Z or Ctrl + Z to undo, just as you would in a document.
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Step 4: Adjust Form Settings

1.	 Settings Icon:

◊	 Click the gear icon in the top-right corner to adjust form settings.

◊	 Options include collecting email addresses, limiting responses, and enabling 
quizzes.

2.	 Themes:

◊	 Click the palette icon to customize the theme, colors, and font of your form.

Step 5: Preview and Test

1.	 Preview Your Form:

◊	 Click the eye icon in the top-right corner to see how your form will appear to 
respondents.

2.	 Test:

◊	 Answer the questions to ensure everything works as expected.

Step 6: Share the Form

1.	 Send Form:

◊	 Click the Send button in the top-right corner.

2.	 Sharing Options:

◊	 Send via email, copy the link, or embed it on a website.

◊	 Use the shorten URL option for a cleaner link if sharing via link.

Step 7: Analyze Responses

1.	 View Responses:

◊	 Go to the Responses tab to see submissions.

2.	 Export to Google Sheets:

◊	 Click the Sheets icon to export responses for further analysis.SG
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                                                    Figure 1.2.8

◊	 Google Form: It is an online application developed by Google that allows 
users to create and distribute forms, surveys, quizzes, and polls easily

◊	 Features of Google Form

◊	 Uses/Application of Google Form

◊	 Creation of Google Form:

Step 1: Access Google Forms

Step 2: Start a New Form

Step 3: Add Questions and Customize

Step 4:Adjust Form Settings

Step 5: Preview and Test

Step 6: Share the Form

Step 7: Analyze Responses

Recap
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1.	 What is Google Forms used for?

2.	 Which suite includes Google Forms?

3.	 Where are form responses stored?

4.	 What type of files can respondents upload?

5.	 How many question types does Google Forms offer?

6.	 Which add-on limits submissions?

7.	 What is the default question type in Google Forms?

8.	 Which tool integrates for advanced analysis?

9.	 How can forms be shared?

10.	 What icon previews the form?

11.	 What field is used for lengthy answers?

12.	 Which format supports videos?

Objective Questions

1.	 Data Collection

2.	 Google Workspace

3.	 Google Sheets

4.	 Any File

5.	 Eleven

6.	 Form Limiter

7.	 Multiple Choice

8.	 Google Sheets

9.	 Email

10.	 Eye Icon

11.	 Paragraph

12.	 YouTube

Answers
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1.	 Explain the features of Google Forms that make it a versatile tool for data 
collection.

2.	 Discuss the integration of Google Forms with Google Sheets and Drive.

3.	 Illustrate the steps to create and share a Google Form.

4.	 Evaluate the applications of Google Forms in different domains.

5.	 Describe the benefits of using templates in Google Forms.

6.	 Create a Google Form to collect feedback on a workshop or event.

7.	 Design a quiz using Google Forms, including multiple-choice and short-
answer questions.

8.	 Use a pre-designed template to create an event registration form.

9.	 Analyse the responses of a survey by exporting data to Google Sheets.

10.	 Collaborate with a peer to design a team survey in real-time.

Assignments

1.	 Roberts, B. (2025). Step-by-step guide to Google Forms. Publisher.

Suggested Reading

1.	 Google. (n.d.). Google Forms. Retrieved from https://forms.google.com

2.	 Google. (n.d.). Google Workspace. Retrieved from https://workspace.
google.com

3.	 Smith, J. (2020). Mastering Google Forms for Data Collection. New York: 
Tech Press. Brown, L. (2021). Simplifying Surveys: The Role of Google 
Forms. Boston: EduTech Publications.
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After the completion of this unit, the learner will be able to;

◊	 comprehend what free software is and why it is important

◊	 learn the differences between free software and open-source software

◊	 explore the benefits and challenges of using free software

◊	 use free software tools to solve real-world problems in business or education

Learning Outcomes

Mr. Ramesh, a nano-business owner operating a home-based bakery, is known 
for the cakes and pastries that he bakes, and by word of mouth, he gets orders 
and enquiries from his neighbourhood and friends. He understands that he can 
easily convert this into a business and start one in his home. He is spending a 
lot of time tracking orders, ensuring dispatch, managing accounts, creating flyers 
and promotional notices on social media, etc, and slowly is unable to concentrate 
on his core expertise of cooking and baking creative cakes. He doesn’t have the 
capital to invest in software to support and complement him in business. It is at 
this juncture that he learns about free software and understands that he can manage 
business by utilising it. Ramesh can benefit from this chapter by learning how 
to utilize free and open-source software to manage inventory, design marketing 
materials, and engage with customers online, thereby optimising their operations 
and reducing costs. This chapter delves into the world of free software, exploring 
its principles, history, and applications. Prior knowledge of basic computer 
literacy, including familiarity with operating systems, software installation, and 
basic file management, is beneficial for understanding the concepts discussed. A 
foundational understanding of business principles, such as budgeting, marketing, 
and customer relationship management, will also be helpful to appreciate how free 
software can be leveraged to address the specific needs of a small business.

Prerequisite

Unit 
1 Free software 
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Free software is a groundbreaking concept that has reshaped the way people 
and organizations interact with technology. Unlike proprietary software, which 
restricts access and usage, free software prioritizes user freedom by allowing 
individuals to use, modify, and distribute programs without limitations. This open 
approach fosters collaboration, transparency, and innovation, making it particularly 
advantageous for small and nano businesses. 

For small businesses and educational institutions, free software is a game-
changer, enabling access to high-quality tools without financial barriers. For 
instance, a small tailoring cum boutique shop can use free design software like 
Inkscape to create attractive flyers, design promotional materials, or manage 
customer orders efficiently using LibreOffice spreadsheets and maintain an online 
presence without incurring high software licensing costs. This chapter provides an 
in-depth exploration of free software, covering its meaning, history, applications, 
advantages, disadvantages, types, and emerging trends, with practical examples 
and exercises for hands-on learning.

 2.1.1 Meaning of Free Software
“Free software ” means software that respects users’ freedom and community that 

means it guarantees certain freedom for software users. These freedom include the 
rights to run, study, modify and share copies of software.  The term “free” signifies 
freedom, not necessarily cost, emphasising the user’s right to control and adapt the 
software. Unlike proprietary software, which limits access and modifications, free 
software ensures openness, enabling communities to share and improve programs 
collectively.

For example, small-scale businesses can customise free software like GIMP or 
LibreOffice to suit their specific needs, such as creating marketing materials or 
managing inventory. This adaptability and user-centred approach make free software 
an essential tool for businesses and individuals alike.

2.1.2 Free Software and Open-Source Software
Free software and open-source software share many principles, as both prioritize 

access to source code, collaboration, and user freedom. However, their philosophies 
and emphases differ. Free software, as championed by the Free Software Foundation, 
emphasizes ethical considerations and user rights, focusing on the freedoms to use, 

Free Software, Open software, Open Source, Licensing, Copyleft, GNU General 
Public License (GPL), Nano Businesses

Keywords

Discussion
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modify, and distribute software. It underscores the idea of software being a public good, 
akin to free speech.

Open-source software, on the other hand, takes a more pragmatic approach. It 
highlights the practical advantages of accessible source code, such as improved quality, 
security, and collaboration. Open-source initiatives often prioritize commercial viability, 
making it appealing to businesses seeking cost-effective and adaptable solutions.

Examples:

◊	 Free Software: GNU Emacs and LibreOffice emphasize user freedom and are 
governed by licenses like the GNU General Public License (GPL).

◊	 Open-Source Software: Projects like Apache HTTP Server and Kubernetes 
focus on collaborative development and often cater to enterprise environments.

For example, a small bakery could use LibreOffice (free software) for managing 
orders and inventory while using Apache HTTP Server (open-source software) to host 
its website. Both tools enhance productivity but reflect different philosophical origins.

Self-Learning Exercise: Choose one free software and one open-source software 
application. Compare their features and discuss how each could benefit a nano business.

2.1.2 History of Free Software
Historical Significance

From its origins in collaborative development to its current role as a cornerstone 
of modern technology, free software has shaped industries and empowered users 
worldwide. For example, Linux, an open-source operating system, powers millions of 
devices today, from servers to smartphones.

2.1.2.1 Early Beginnings

The concept of free software dates back to the 1950s and 1960s, when software was 
freely shared among researchers and developers. At that time, software development 
was collaborative, and programs were often distributed with their source code. This 
open exchange of ideas laid the groundwork for the free software movement.

2.1.2.2 The Birth of the Free Software Foundation

In the early 1980s, proprietary software began to dominate the market, restricting user 
freedom. In response, Richard Stallman founded the Free Software Foundation (FSF) 
in 1985, advocating for software freedom. Stallman also launched the GNU Project to 
develop a fully free operating system. The GNU General Public License (GPL) became 
a cornerstone of this movement, ensuring that software remains free and open.

2.1.2.3 The Rise of Open Source

While the term “free software” emphasised freedom, the 1990s saw the emergence 
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of the “open source” initiative, focusing on the practical benefits of openness. This shift 
in terminology helped attract businesses and governments, leading to the widespread 
adoption of free and open-source software.

2.1.3 Uses of Free Software
Free software is employed across various sectors, including education, healthcare, 

governance, and business. It enables individuals and organisations to perform essential 
tasks without financial or technical barriers. In education, free software tools like 
Moodle are used for online learning management. Governments adopt free software to 
promote transparency and save costs in public administration. Nano businesses leverage 
free software for accounting, marketing, and operational efficiency.

For instance, a local bakery could use GNU Image Manipulation Program (GIMP) to 
design promotional flyers, LibreOffice to manage orders and invoices, and WordPress 
to create a website showcasing their products. These tools empower the business to 
maintain professionalism and expand its reach without incurring high software expenses.

2.1.3.1 Education and Research

Educational institutions use free software like Moodle for managing online courses 
and LibreOffice for teaching basic computing skills. Students and teachers benefit from 
tools that are cost-effective and adaptable.

2.1.3.2 Government and Public Sector

Governments adopt free software for transparency, cost savings, and security. For 
example, several countries have transitioned to Linux-based systems for public offices.

2.1.3.3 Nano Businesses

Nano businesses, with limited budgets, leverage free software to optimize operations. 
A home-based bakery can use LibreOffice to track orders, GIMP for designing labels, 
and social media tools integrated with open-source platforms to market their products.

2.1.4 Characteristics of Free Software
Free software is rooted in the principles of freedom and collaboration, offering users 

Self-Learning Exercise:

Research and write about the GNU Project and its significance in the history 
of free software. Include examples of software created under the GNU initiative.

Self-Learning Exercise: 

Think of a nano business in your community (e.g., education, healthcare, or 
retail) and research how free software is used in that field. Write a brief report 
highlighting three key tools and their applications.
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an alternative to restrictive paid or proprietary software. Unlike proprietary software, 
which imposes limitations on usage, modification, and sharing, free software empowers 
users with unparalleled control over their tools. Below, we explore the core freedoms 
of free software and its advantages and disadvantages, with detailed examples tailored 
to nano-business enterprises.

2.1.4.1  Freedom to Use

Free software allows individuals and businesses to use it for any purpose, be it 
personal, commercial, or educational, without any cost or licensing restrictions. This 
accessibility makes it an invaluable resource for small businesses and startups that often 
operate on tight budgets. The lack of restrictions means businesses can use the software 
creatively and in ways that best suit their operations.

Example: Consider a small social media agency managing multiple clients. They can 
use free tools like “Buffer” or open-source alternatives to paid social media schedulers. 
These tools allow them to plan and schedule posts across platforms, analyze campaign 
performance, and engage with audiences—all without incurring hefty subscription fees. 
By reducing costs, the agency can focus its resources on scaling its business or hiring 
additional staff.

2.1.4.2 Freedom to Study and Modify

One of the most powerful aspects of free software is access to its source code. This 
transparency enables businesses to understand how the software works and customize it 
to meet their specific needs. This flexibility is particularly beneficial for nano businesses 
that require tailored solutions to stand out in their niches.

Example: A nano business specializing in custom website design can leverage 
“WordPress,” an open-source Content Management System (CMS). With access to the 
source code, the business can modify the platform to include unique design elements, 
bespoke functionality, or integration with specific third-party tools. This capability 
allows the business to provide exceptional value to its clients while also differentiating 
itself in the competitive web development market.

2.1.4.3 Freedom to Share

Free software encourages knowledge sharing and collaboration by allowing users to 
freely distribute copies. This creates opportunities for businesses to foster communities, 
build partnerships, and extend their impact. Sharing software tools and knowledge can 
also position a nano business as a leader in its field.

Example: A nano business that runs coding workshops can distribute free programming 
tools like Python, LibreOffice, or Scratch to its students. By doing so, they reduce 
training costs while promoting a culture of collaboration and open learning. This 
approach not only strengthens the business’s reputation but also builds a community of 
loyal learners who are likely to recommend its services.
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2.1.4.4 Freedom to Improve and Share Improvements

Users of free software can not only enhance the tools they use but also share their 
improvements with the community. This cycle of improvement benefits both the user 
and the wider ecosystem. For businesses, contributing to software development can 
enhance their technical capabilities and establish their credibility in the industry.

Example: A small tech startup using an open-source inventory management system can 
identify bugs or missing features. By fixing these issues and sharing the improvements 
with the community, the startup not only improves its own operations but also builds 
goodwill and recognition among peers. This collaborative effort can lead to partnerships 
or even attract new clients.

2.1.4.5 Eliminates licensing costs

Cost-effectiveness is a significant advantage of free software, as it eliminates 
licensing costs. This makes it accessible to individuals, small businesses, and nonprofits 
that may have limited budgets. 

Example: Schools and educational institutions can use free software to provide learning 
tools to students without worrying about financial constraints.

2.1.4.6 Community-driven Development Model

A major driver behind the innovation in free software is its community-driven 
development model. A global network of developers and users actively contribute to 
its improvement by fixing bugs, adding features, and offering support. Projects like 
Linux and Mozilla Firefox thrive because of the collaborative efforts of their vibrant 
communities.

2.1. 4.7 Independence from vendor lock-in 

Free software provides independence from vendor lock-in, empowering users to 
make changes, switch providers, or integrate new tools without being tied to a single 
vendor’s ecosystem. This freedom ensures users retain control over their software and 
data, even if they decide to move to a different platform.

2.1.4.8 Culture of innovation and collaboration 

Another notable characteristic is the culture of innovation and collaboration fostered 
by free software. Developers can build upon existing tools to create new solutions, 
often sharing their advancements with the wider community. This approach drives 
rapid technological progress and benefits a broad range of users.

2.1.4.9 Cross-platform compatibility

Many free software tools are designed with cross-platform compatibility, allowing 
them to function seamlessly on different operating systems like Windows, macOS, 
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and Linux. This accessibility ensures users can choose free software without being 
constrained by their current hardware or operating system.

2.1.4.10 Extensive Customisation Options

Finally, free software offers extensive customisation options, enabling individuals 
and organisations to modify the software to suit their exact needs. For example, a 
nonprofit organisation could tailor free software to align with its unique outreach or 
fundraising strategies, ensuring an optimal fit for its goals.

    Advantages and Disadvantages of Free Software

From the practical perspectives of users, there are several advantages for free 
software. In fact what makes it so attractive is its economic cost, although often free is 
not synonymous with quality.

2.1.5 Advantages of free soft ware
There are many advantages of free software, since these programmes are designed to 

satisfy all the needs of users. Some of the most relevant are discussed below.

2.1.5.1 Cost Savings

Free software eliminates the need for licensing fees, making it ideal for nano 
businesses operating on limited budgets. The cost savings allow businesses to allocate 
resources to other critical areas, such as marketing, product development, or hiring.

Example: A nano graphic design studio can use “GIMP,” a free and versatile image 
editing tool, as an alternative to expensive software like Adobe Photoshop. This choice 
significantly reduces operating costs without compromising on quality, enabling the 
studio to remain competitive and profitable.

2.1.5.2 Customizable and Flexible

The ability to modify free software enables businesses to tailor it precisely to 
their operational needs. This flexibility can lead to increased efficiency and a more 
personalized experience for customers.

Example: A small e-commerce business can customize an open-source platform like 
“WooCommerce” to integrate with specific payment gateways, shipping providers, 
or inventory management tools. By creating a seamless and personalized shopping 
experience, the business can enhance customer satisfaction and drive growth.

2.1.5.3 Reliable and Secure

Free software is often more reliable and secure than proprietary alternatives due to 
its collaborative development model. A global community of developers continuously 
reviews the code, identifying and addressing vulnerabilities faster than many commercial 
software providers.
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Example: A nano IT service provider can use “Linux” as its server operating system. 
Linux’s strong security features, combined with an active support community, make it 
a robust choice for protecting sensitive data and maintaining operational stability.

2.1.5.4 Encourages Innovation

Free software fosters a culture of innovation by enabling users to experiment, 
develop, and share new ideas. This open environment accelerates advancements and 
keeps businesses competitive in rapidly evolving markets.

Example: A nano business in data analytics can use free tools like “Python” or “R” 
to analyse large datasets, visualise trends, and model outcomes. These tools, regularly 
updated with new libraries and algorithms, allow the business to stay ahead of industry 
trends and deliver cutting-edge insights to clients.

2.1.6 Disadvantages of Free Software
Just as free software has several advantages, some demerits also can be observed 

which are discussed below.

2.1.6.1 Steep Learning Curve

Free software may come with a steeper learning curve, especially for users who 
are accustomed to user friendly, proprietary alternatives. Many free software tools are 
feature-rich and complex, requiring users to invest time and effort to learn how to use 
them effectively. For businesses with limited technical expertise, this can be a challenge.

Example: A nano business owner without IT skills might struggle to set up an open-
source inventory management system like “Odoo.” The complexity of installation and 
configuration may require additional time or hiring an expert, which could increase 
costs initially.

2.1.6.2 Limited Professional Support

While free software often has active user communities, dedicated commercial 
support is not always available. This can make resolving critical issues more difficult 
for businesses that rely heavily on the software.

Example: If an open-source accounting tool encounters a critical error, a nano business 
might face delays in resolving the issue due to the lack of immediate professional 
support. In contrast, proprietary software often provides dedicated customer service for 
such scenarios.

2.1.6.3 Compatibility & Integration Issues

Integrating free software with existing proprietary tools or hardware can sometimes 
be challenging. These compatibility issues may disrupt workflows or require additional 
resources to resolve.
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Example: A nano café using an open-source billing system might face difficulties 
integrating it with a proprietary POS system, leading to operational inefficiencies. 
Addressing such challenges may require technical expertise or alternative solutions.

2.1.6.4 Security Risks (Though Minimal)

Although free software is generally secure, its open-source nature can expose 
potential vulnerabilities. Malicious actors may exploit these vulnerabilities before they 
are identified and fixed. Unlike proprietary software, where vendors often have strict 
security protocols ,security of free software  largely depend on community vigilance, 
which may not be always reliable and immediate. 

Example: A nano business using an outdated version of an open-source CRM 
might unknowingly expose customer data to risks. Regular updates and community 
involvement can mitigate these risks, but businesses must remain vigilant.

2.1.7  Types of Free Software
Free software, a concept that has revolutionised the technological landscape, 

encompasses a spectrum of licenses and philosophies. This chapter delves into the 
various types of free software, examining their defining characteristics and the unique 
freedoms they grant to users.

At its core, free software is not synonymous with “free of cost.” Instead, it emphasises 
four fundamental freedoms:

1.	 The freedom to run the program as you wish, for any purpose.

2.	 The freedom to study how the program works and adapt it to your needs. This 
implies access to the source code.   

3.	 The freedom to distribute copies of the program to others, so you can share it 
with your community.

4.	 The freedom to improve the program, and release your improvements to the 
public, so that the whole community benefits.

These freedoms, collectively known as the “four essential freedoms,” form the 
bedrock of the free software movement. However, different licenses interpret and 
implement these freedoms in distinct ways.   

2.1.7.1 Copyleft License

One prominent category of free software licenses is the copyleft license. These 
licenses, such as the GNU General Public License (GPL), ensure that any derivative 
works created from the original software must also be distributed under the same or a 
compatible free software license. This “copyleft” provision promotes the sharing and 
collaborative development of software, ensuring that it remains free for all users.
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A prime example of the GPL in action is the Linux kernel, the foundation of many 
popular operating systems, including Android. The GPL ensures that any modifications 
or distributions of the Linux kernel must also be made available under the GPL, fostering 
a vibrant community of developers who contribute to its ongoing development and 
improvement. This collaborative model has been instrumental in the success of Linux, 
powering everything from supercomputers to smartphones.

For nano-businesses, the GPL can be particularly advantageous. By building upon 
and contributing to existing GPL-licensed software, nano-businesses can leverage the 
work of a large community, reducing development costs and accelerating time-to-
market. For instance, a nano-business developing a specialized application for a niche 
market could utilize a GPL-licensed database system or a framework, customizing it 
to meet their specific needs while ensuring that their own contributions also benefit the 
larger community.

2.1.7.2 Permissive License

In contrast to copyleft licenses, permissive licenses offer greater flexibility in how 
users can utilise and distribute the software. The MIT License and the BSD License are 
examples of permissive licenses. These licenses generally allow users to use, modify, 
and distribute the software, even in proprietary projects, without the obligation to 
release their modifications under the same license.

A notable example of software distributed under the MIT License is React, a popular 
JavaScript library for building user interfaces. The permissive nature of the MIT 
License has enabled React to gain widespread adoption in the developer community, 
empowering developers to use and modify it freely in a variety of projects, from small 
personal projects to large-scale enterprise applications.

For nano-businesses operating in fast-paced and competitive environments, the 
flexibility of permissive licenses can be highly valuable. They allow for rapid prototyping, 
experimentation, and integration with other proprietary software components. A nano-
business developing a mobile application, for example, could utilise a permissively 
licensed library for image processing, incorporating it into their proprietary application 
without the constraints of a copyleft license.

2.1.7.3 Weak Copyleft License

Beyond copyleft and permissive licenses, other categories of free software licenses 
exist, such as weak copyleft licenses and public domain dedications. Weak copyleft 
licenses, such as the GNU Lesser General Public License (LGPL), offer a compromise 
between copyleft and permissive licenses. They typically apply copyleft restrictions to 
certain parts of the software while allowing other parts to be used under more flexible 
terms.

The GIMP, a popular open-source image editor, is an example of software distributed 
under the LGPL. The LGPL allows developers to link their proprietary applications with 
the GIMP libraries, providing flexibility for commercial use while still ensuring that the 
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core GIMP libraries remain free and open source. This approach can be particularly 
beneficial for nano-businesses that develop software that interacts with or extends the 
functionality of existing open-source tools.

2.1.7.4 Public Domain Dedications

Public domain dedications, on the other hand, relinquish all copyright claims on the 
software, effectively placing it in the public domain. This allows users to freely use, 
modify, and distribute the software without any restrictions.

Understanding the different types of free software licenses is crucial for developers, 
users, and businesses. Choosing the appropriate license for a software project involves 
careful consideration of the project’s goals, the desired level of freedom for users, and 
the long-term sustainability of the software.

By embracing the principles of free software, individuals and organisations can 
contribute to a more open, collaborative, and equitable technological landscape. Free 
software empowers users, fosters innovation, and promotes the sharing of knowledge 
and resources, ultimately benefiting society as a whole.

2.1.7.5 Latest Trends in Free Software
i.	 Cloud Integration: The convergence of free software with cloud computing 

platforms like AWS, Google Cloud, and Azure is rapidly gaining momentum. 
This integration leverages the cost-effectiveness and flexibility of free software 
with the scalability, on-demand resources, and robust infrastructure provided by 
cloud computing services.

ii.	 AI and Machine Learning: The development of free and open-source AI and 
ML frameworks and libraries is accelerating at an unprecedented pace. This 
trend empowers developers and researchers to build and deploy sophisticated 
AI-powered applications without relying on expensive proprietary software.

iii.	 Internet of Things (IoT): Free software plays a pivotal role in the development 
of IoT devices and applications. Open-source operating systems, communication 
protocols, and development frameworks are essential for building secure, 
interoperable, and innovative IoT solutions.

iv.	 Blockchain and Decentralized Applications (dApps): Free software forms 
the bedrock of blockchain technology and decentralised applications. Open-
source blockchain platforms and development tools enable the creation of 
secure, transparent, and decentralised applications that revolutionise various 
sectors, including finance, supply chain management, and healthcare.

The world of free software is a testament to the power of community, collaboration, 
and user empowerment. By embracing the principles of freedom and sharing, the free 
software movement has fostered innovation, spurred technological advancements, and 
democratised access to knowledge and technology.

Nano-businesses can significantly benefit from the free software ecosystem. By 
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leveraging existing free software tools, libraries, and frameworks, they can reduce 
development costs, accelerate time-to-market, and gain a competitive edge. Whether it’s 
utilising GPL-licensed software for collaborative development, employing permissively 
licensed components for rapid prototyping, or integrating with LGPL-licensed libraries 
for interoperability, free software offers a powerful toolkit for innovation and growth.

By understanding the nuances of free software licenses and strategically choosing 
the right ones for their projects, nano-businesses can contribute to a more open and 
collaborative technological landscape while simultaneously achieving their business 
objectives.

This chapter has provided a foundational understanding of the diverse world of free 
software licenses, including their potential applications for nano-businesses. Further 
exploration into specific licenses and their legal implications is encouraged for those 
seeking a deeper dive into this critical area of software development and utilisation.

◊	 Free software emphasizes user freedom, offering the ability to use, modify, 
and share programs.

◊	 Historical Context: The free software movement emerged to counteract 
proprietary software restrictions, promoting collaboration and transparency.

◊	 Advantages: Cost savings, flexibility, security, and innovation make free 
software appealing to businesses and institutions.

◊	 Disadvantages: Challenges include a learning curve, limited support, and 
occasional compatibility issues.

◊	 Applications: Free software is widely used in education, governance, nano 
businesses, and technological innovation.

◊	 Types of Licenses: Copyleft, permissive, weak copyleft, and public domain 
licenses offer varied levels of user freedom and obligations.

◊	 Trends: Integration with cloud computing, AI/ML frameworks, IoT, and 
blockchain technologies is on the rise.

Recap

1.	 What does “free” in free software primarily signify?

2.	 Which license is commonly associated with free software?

3.	 Name an example of free software.
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4.	 What is the main difference between free software and open-source software?

5.	 Who founded the Free Software Foundation?

6.	 Which free software tool is used for graphic design?

7.	 What is the primary advantage of free software for nano businesses?

8.	 Which decade saw the emergence of the Free Software Foundation?

9.	 Name a permissive software license.

10.	 What is the focus of the open-source initiative?

11.	 Which operating system is an example of free software?

12.	 What is one drawback of free software?

1.	 User freedom

2.	 GNU General Public License

3.	 LibreOffice

4.	 Philosophical emphasis

5.	 Richard Stallman

6.	 GIMP

7.	 Cost savings

8.	 1980s

9.	 MIT License

10.	 Practical advantages

11.	 Linux

12.	 Steep Learning curve

Answers
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1.	 Explain the core freedoms of free software and their significance.

2.	 Discuss the differences and similarities between free software and open-
source software.

3.	 How does free software benefit nano businesses? Provide examples.

4.	 Describe the types of free software licenses with relevant examples.

5.	 Discuss the latest trends in free software and their potential impacts on 
technology and business.

6.	 Write a one-page essay on how free software can transform a small business 
in your community. Include specific examples and applications.

7.	 Create a hypothetical nano business scenario and list three free software 
tools you would use to solve operational challenges, explaining why each 
tool is suitable.

8.	 Explore Free Software: Install and experiment with two free software tools 
(e.g., LibreOffice and GIMP). Write a report on their features and usability.

9.	 Compare a free software application with its proprietary counterpart in 
terms of cost, features, and usability.

10.	 Case Study: Identify a nano business in your locality and develop a proposal 
on how it can integrate free software to improve operations.

Assignments

1.	 Fadel, A. (2013). The book on free software.

2.	 Feller, J. (2005). Perspectives on free and open source software. MIT Press.

3.	 Andrew, M. (2004). Open source and free software licensing. O'Reilly 
Media.
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Upon the completion of this unit, the learner will be able to;

◊	 comprehend the features and functionality of OpenOffice Writer for creating 
and editing documents

◊	 use tools like formatting, hyperlinking, and paragraph styling for professional 
document creation

◊	 identify and utilise the menu bar, status bar, and toolbar for efficient document 
handling

◊	 apply OpenOffice Writer to real-world scenarios, such as creating promotional 
materials and managing business documents

Learning Outcomes

Understanding how to use OpenOffice Writer can be a game-changer for nano 
businesses, which often operate with limited resources and tight budgets. For 
instance, imagine a small bakery run by a local entrepreneur. The bakery wants to 
promote its special cakes and pastries during the festive season but cannot afford 
professional design software or printing services. With OpenOffice Writer, the 
owner can create an attractive promotional flyer, complete with eye-catching text, 
formatted headings, special symbols like “₹” for pricing, and even inserted images 
of the bakery’s products.

Using the hyperlink feature, the flyer can include clickable links to the bakery’s 
social media pages or online order forms, making it easy for customers to engage. 
Additionally, the owner can use the Find and Replace feature to quickly update the 
flyer’s content for different occasions, like replacing “Christmas Specials” with 
“Diwali Delights.” By mastering Writer, the bakery owner saves money, increases 
productivity, and presents the business in a professional and appealing way. This 
example highlights the practicality and importance of knowing Writer for any 
nano business striving to create high-quality documents independently.

Prerequisite

Unit 
2 Introduction to Writer 
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 2.2.1 OpenOffice Writer 
OpenOffice Writer is a powerful word processing tool that is part of the Apache 

OpenOffice suite, an open-source office software package. As a versatile and user-
friendly program, OpenOffice Writer provides an excellent platform for creating and 
editing text documents, making it a valuable resource for students, professionals, 
and organisations. The software supports a wide range of features, including text 
formatting, table creation, image insertion, and advanced tools such as mail merge 
and macro scripting. Moreover, being open source, it is available free of charge 
and supports multiple operating systems, including Windows, macOS, and Linux.

OpenOffice Writer’s compatibility with popular file formats like Microsoft 
Word’s DOC and DOCX, as well as the OpenDocument Text (ODT) format, 
ensures seamless collaboration and sharing. The software’s intuitive interface and 
rich functionality make it an ideal choice for creating various types of documents, 
including essays, reports, and newsletters. Additionally, the support for extensions 
allows users to enhance its capabilities, tailoring the tool to their specific needs. 
Writer is similar to Microsoft Word but is free and open source, making it an ideal 
choice for students, small businesses, and startups.

For example, consider a home bakery that needs to prepare price lists and 
promotional flyers. Using Writer, the bakery owner can create eye-catching 
documents to distribute to customers or post online. Writer supports various file 
formats, including .doc and .docx, allowing seamless sharing with clients and 
printers. Additionally, Writer’s ability to export directly to PDF ensures that the 
documents retain their formatting across all devices.

Key Features:

◊	 Spell-check and grammar suggestions

◊	 Easy formatting of text and paragraphs

◊	 Inserting images, tables, and charts

◊	 Compatibility with multiple file formats like .docx and .odt

Example Scenario:

A nano business owner running a handmade crafts shop can use Writer to create 
professional-looking product catalogues or marketing flyers at zero software cost.

Openoffice Writer, Formatting, Hyphenating, Paragraphs, Cut, Copy, Paste, 
Find and Replace, Hyperlinking, Paragraph Styling

Keywords

Discussion
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In this chapter, we will first explore the process of installing OpenOffice Writer, 
which is the first step toward harnessing the potential of this remarkable software.

2.2.2 Setting up Writer
1.	 Installing OpenOffice

Installing OpenOffice Writer is a straight  forward process that ensures you can begin 
creating documents in no time. Follow the detailed instructions below to get started.

a.	 Download the software.

To download OpenOffice, visit the official Apache OpenOffice website at https://www.
openoffice.org. Once there, navigate to the download section prominently displayed 
on the homepage. Click the “Download” button, and the website will automatically 
detect your operating system to provide the correct version of the software. Save the 
installation file to your preferred location on your computer.

b.	 Install the software.

After the download is complete, locate the file in your computer’s download folder 
or the location you chose while downloading. The file will usually have a name like 
“Apache_OpenOffice_version_Setup.exe” (for Windows) or a similar format for 
macOS and Linux. Double-click on this file to begin the installation process.

When you open the installation file, a setup wizard will appear on your screen. This 
wizard simplifies the installation process by guiding you through each step. First, you’ll 
see a welcome screen. Click “Next” to proceed. You will then be presented with the 
license agreement. Take a moment to read the terms and conditions and click “I accept” 
to move forward.

Next, you’ll be asked to choose an installation type. If you’re unsure, select the 
“Standard” option, which installs the most commonly used features. Advanced users 
can choose “Custom” to select specific components or adjust settings based on their 
needs.

Once you’ve selected your installation preferences, the wizard will begin copying 
files and configuring the program on your computer. This process may take a few 
minutes, depending on your system’s speed. You’ll see a progress bar indicating how 
far along the installation is. When it’s finished, a confirmation message will appear. 
Click “Finish” to complete the installation.

c.	 Launch Writer from the OpenOffice application menu.

Now that the software is installed, you can start using OpenOffice Writer. Look for 
the Apache OpenOffice shortcut on your desktop or in your applications folder. Double-
click the icon to open the program. The first time you launch OpenOffice, it may prompt 
you to register your copy. Registration is optional and can be skipped. After this, you’ll 
see the main OpenOffice Writer interface, ready for you to begin your work.
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All Writer documents are associated with the Writer application. This means that you 
can start OpenOffice.org automatically, simply by double-clicking a Writer document 
in a file manager such as Windows Explorer. 

You can spot an OpenOffice.org Writer document by its  icon.

2.	 Exploring the Interface

◊	 Menu Bar: Contains options like File, Edit, View, and Tools.

◊	 Toolbar: Provides shortcuts to frequently used commands (e.g., Save, Print, 
Bold).

◊	 Workspace: The main area where you type and edit your text.

◊	 Status Bar: Displays information like the page number and word count.

      

                                                           Figure 2.2.1

Let’s discuss in detail Menu Bar and Status Bar as familiarising them will be pivotal 
in gaining practical hands-on knowledge to use Office Writer. Toolbar will be discussed 
subsequently in this chapter in detail.

Menu Bar

The Menu bar is located across the top of the Writer window, just below the Title 
bar. When you choose one of the menus, a submenu drops down to show commands.

◊	 File: Contains commands that apply to the entire document such as Open, Save, 
and Export as PDF.

◊	 Edit: Contains commands for editing the document such as Undo and Find & 
Replace.

◊	 View: Contains commands for controlling the display of the document such as 
Zoom and Web Layout.

◊	 Insert: Contains commands for inserting elements into your document such as 
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headers, footers, and pictures.

◊	 Format: Contains commands for formatting the layout of your document, such 
as Styles and Formatting, Paragraph, and Bullets and Numbering.

◊	 Table: Shows all commands to insert and edit a table in a text document.

◊	 Tools: Contains functions such as Spellcheck, Customize, and Options.

◊	 Window: Contains commands for the display window.

◊	 Help: Contains links to the Help file, What’s This? and information about the 
program.

For example, a small tailoring business that creates promotional brochures might use 
Writer to prepare content. The owner can start by selecting the A4 page size under the 
“Format” menu to ensure the brochure is suitable for printing. By adjusting the margins 
and orientation, they can further customize the layout.

Status Bar

The Writer status bar provides information about the document and convenient ways 
to quickly change some document features.

        

                                                      Figure 2.2.2

◊	 Page number: Shows the current page number, the sequence number of the 
current page (if different), and the total number of pages in the document. 
For example, if you restarted page numbering at 1 on the third page, its page 
number is 1 and its sequence number is 3. If any bookmarks have been defined 
in the document, a right-click on this field pops up a list of bookmarks; click 
on the required one. To jump to a specific page in the document, double-click 
on this field. The Navigator opens. Click in the Page Number field and type the 
sequence number of the required page. After a brief delay, the display jumps to 
the selected page. 

◊	 Page style: Shows the style of the current page. To change the page style, right-
click on this field. A list of page styles pops up; choose a different style by 
clicking on it. To edit the current page style, double-click on this field. The Page 
Style dialog opens. 

◊	 Language: Shows the language for the selected text. Click to open a menu 
where you can choose another language for the selected text or for the paragraph 
where the cursor is located. You can also select None (Do not check spelling) to 
exclude the text from a spelling check.

◊	 Insert mode: Click to toggle between Insert and Overwrite modes when typing. 

SG
O
U



        SGOU - SLM -  UG - AC Course - Software For Office Management60

◊	 Selection mode: Click to toggle between STD (Standard), EXT (Extend), ADD 
(Add) and BLK (Block) selection. EXT is an alternative to Shift+click when 
selecting text. See “Working with Text” on page 11 for more information about 
ADD and BLK. 

◊	 Unsaved changes: An asterisk (*) appears here if changes to the document 
have not been saved.

         

                                                          Figure 2.2.3

◊	 Digital signature: If the document has been digitally signed, an icon shows 
here. You can double-click the icon to view the certificate. 

◊	 Section or object information: When the cursor is on a section, heading, or 
list item, or when an object (such as a picture or table) is selected, information 
about that item appears in this field. Double-clicking in this area opens a relevant 
dialog. For details, consult the Help or the Writer Guide. 

◊	 View layout: Click an icon to change between single page, side-by-side, and 
book layout views. The effect varies with the combination of window width and 
zoom factor in use. You can edit the document in any view.

◊	 Zoom: To change the view magnification, drag the Zoom slider, or click on 
the + and — signs, or right-click on the zoom level percent to pop up a list of 
magnification values from which to choose. Zoom interacts with the selected 
view layout to determine how many pages are visible in the document window.

◊	

◊	

◊	

◊	

3.	 Working with Text

OpenOffice Writer provides an intuitive and versatile platform for working with 
text. This subchapter introduces you to the basics of typing and editing text, as well as 
selecting text efficiently. Understanding these features will help you create polished and 
professional documents.

Working with text (selecting, copying, pasting, moving) in Writer is similar to 
working with text in any other program. Apache OpenOffice also has some convenient 
ways to select items that are not next to each other, select a vertical block of text, and 
paste unformatted text.

Self-Learning Exercise:

1.	 Open Writer and familiarize yourself with the interface. 

2.	 Write a 50-word paragraph about your favourite hobby and locate the 
word count on the status bar.
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Imagine a local grocery store owner using Writer to create a weekly discount flyer. 
They can type a list of discounted items and their prices in a neat format. If a typo 
occurs, it can be corrected instantly using the backspace or delete key. Additionally, you 
can enhance the text by changing fonts, sizes, and colours using the toolbar options at 
the top of the screen.

a.	 Typing and Editing Text

Typing in OpenOffice Writer is as simple as placing the cursor in the blank document 
and beginning to type. The text wraps automatically to fit within the page margins, 
ensuring a neat appearance. You can adjust the cursor’s position by clicking anywhere 
in the document or using the arrow keys on your keyboard. The program allows for free 
navigation, making it easy to enter or modify content at any location.

Editing text involves making changes to the existing content. You can delete unwanted 
characters using the Backspace key for the text behind the cursor or the Delete key for 
the text in front. Inserting new content is equally straightforward: place the cursor at the 
desired position and start typing.

OpenOffice Writer also includes undo and redo functionalities to help manage 
changes. Mistakenly deleted a word? Press Ctrl+Z to undo. Changed your mind again? 
Press Ctrl+Y to redo. These tools are accessible from the toolbar and are invaluable for 
efficiently managing edits.

Formatting is a key aspect of creating a visually appealing document. OpenOffice 
Writer offers a wide array of formatting options, such as bold, italics, underlining, font 
size adjustments, and colour changes. These tools are readily available in the toolbar, 
allowing you to emphasize important points or differentiate sections of text easily.

b.	 Selecting Text

Selecting text is crucial for applying edits, formatting, or moving content. To select 
text using a mouse, click and hold the left button at the starting point of the desired text, 
then drag to the endpoint. Release the button, and the text will be highlighted. Double-
clicking on a word selects it entirely, while triple-clicking selects the entire paragraph.

Keyboard shortcuts also simplify text selection. Hold the Shift key and use arrow 
keys to select text incrementally. This method provides precision and is especially useful 
for working on lengthy documents. For larger sections, use the Ctrl+Shift combination 
along with the arrow keys to select entire words or lines efficiently.

Once selected, text can be copied, cut, or pasted using the toolbar buttons or shortcut 
keys: Ctrl+C (copy), Ctrl+X (cut), and Ctrl+V (paste). Right-clicking on the selection 
brings up a context menu with these and other options, making text manipulation 
intuitive and flexible.

For example, a small travel agency preparing a travel itinerary might want to highlight 
the destination names in bold. To do this, the agency can select the destination names by 
double-clicking each and then applying the bold option from the toolbar.
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Advanced selection techniques include using the Ctrl key while clicking to select 
multiple, non-contiguous pieces of text. This is useful for applying consistent formatting 
to different parts of a document simultaneously.

◊	 Using the Mouse: Click and drag over the text to select it.

◊	 Using the Keyboard: Hold the Shift key and use arrow keys to select text.

You can select a vertical block or “column” of text that is separated by spaces or tabs 
(as you might see in text pasted from e-mails, program listings, or other sources), using 
Writer’s block selection mode. To change to block selection mode, use Edit > Selection 
Mode > Block Area, or click several times in the status bar on STD until it changes to 
BLK.

                                                       Figure 2.2.4

Now highlight the selection, using the mouse or keyboard, as shown below.

        

  

                                                       Figure 2.2.5

Self-Learning Exercise:

Type a sentence, select it using the mouse, and then try selecting it using the keyboard 
shortcuts.

4.	 Cutting, Copying, and Pasting Text

Working with text (selecting, copying, pasting, moving) in Writer is similar to 
working with text in any other program. Apache OpenOffice also has some convenient 
ways to select items that are not next to each other, select a vertical block of text, and 
paste unformatted text.

Cutting and copying text in Writer is similar to cutting and copying text in other 
applications. You can use the mouse or the keyboard for these operations. You can copy 
or move text within a document, or between documents, by dragging or by using menu 
selections, icons, or keyboard shortcuts. Likewise, you can also copy text from other 
sources such as Web pages and paste it into a Writer document.

To move (cut and paste) selected text using the mouse, drag it to the new location and 
release it. To copy selected text, hold down the Ctrl key while dragging. The text retains 
the formatting it had before dragging.

For example, a freelance graphic designer writing an email proposal can reuse 
sections like pricing details by copying them from a previous document and pasting 
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them into the new one. Similarly, cutting and pasting helps move paragraphs around to 
improve the flow of the document.

When you paste text, the result depends on the source of the text and how you paste 
it. If you click on the Paste icon, any formatting the text has (such as bold or italics) is 
retained. Text pasted from Websites and other sources may also be placed into frames 
or tables. If you do not like the results, click the Undo icon or press Ctrl+Z.

To make the pasted text take on the formatting of the surrounding text where it is 
being pasted:

Choose Edit > Paste Special, or

Click the triangle to the right of the Paste icon, or

Click the Paste icon without releasing the left mouse button.

Then select Unformatted text from the resulting menu.

The range of choices on the Paste Special menu varies depending on the origin and 
formatting of the text (or another object) to be pasted. See Figure for an example with 
text on the clipboard.

               

                                                        Figure 2.2.6

Cutting Text:

◊	 Select the text using mouse or keyboard.

◊	 Right-click and choose “Cut” or press Ctrl + X.

Copying Text:

◊	 Select the text using mouse or keyboard.

◊	 Right-click and choose “Copy” or press Ctrl + C.

Pasting Text:

◊	 Place the cursor where you want to paste.

◊	 Right-click and choose “Paste” or press Ctrl + V.
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Example Scenario:

A nano business can use this feature to duplicate sections of product descriptions or 
move text to different parts of a promotional flyer.

5.	 Moving Paragraphs Quickly

Rearranging text in a document is simple with Writer. If you need to move a 
paragraph to a different section, select the entire paragraph and cut it using Ctrl + X. 
Then, position the cursor where you want the paragraph to appear and paste it with Ctrl 
+ V. This method is much faster and more efficient than retyping the content.

For example, a small online bookstore compiling a catalogue might decide to 
place the most popular book categories at the top of the document. By moving these 
paragraphs quickly, the catalogue becomes more customer-focused and effective.

6.	 Finding and Replacing Text

The writer has two ways to find text within a document: the Find toolbar for fast 
searching and the Find & Replace dialog. In the dialog, you can:

◊	 Find and replace words and phrases

◊	 Use wildcards and regular expressions to fine-tune a search

◊	 Find and replace specific formatting

◊	 Find and replace paragraph styles

The Find and Replace feature in Writer is a powerful tool for locating specific words 
or phrases and replacing them with new ones. To find text, press Ctrl + F and type 
the word or phrase you want to search for in the toolbar that appears. To replace text, 
use the Ctrl + H shortcut to open the Find & Replace dialog box. Enter the word to 
be replaced and the replacement text, then choose Replace All to make the changes 
throughout the document.

For instance, a homemade candle business might update all instances of “Winter 
Collection” in their brochure to “Holiday Collection” in preparation for the festive 
season. This feature saves time and ensures consistency across documents.

Moving Paragraphs:

3.	 Select the paragraph you want to move

4.	 Cut it (Ctrl + X)

5.	 Place the cursor where you want the paragraph to appear 
and paste (Ctrl + V)
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Using the Find Toolbar

If the Find toolbar is not visible, you can display it using View > Toolbars > Find.

                                   

                                                      Figure 2.2.7

To use the Find toolbar, click in the box and type your search text, then press Enter 
to find the next occurrence of that term. Click the Find Next or Find Previous buttons 
(up and down arrows) as needed.

Using the Find & Replace dialog

To display the Find & Replace dialog, use the keyboard shortcut Ctrl+F or choose 
Edit > Find & Replace from the menu bar. Optionally, click the More Options button to 
expand the dialog, the button changes to Fewer Options.

              

      

                                                    Figure 2.2.8

To use the Find & Replace dialog:

1.	 Type the text you want to find in the Search for box.

2.	 To replace the text with different text, type the new text in the Replace with 
box.

3.	 You can select various options such as matching the case, matching whole words 
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only, or doing a search for similar words.

4.	 When you have set up your search, click Find. To replace text, click Replace 
instead.

6.1 Finding Text

◊	 Press Ctrl + F to open the Find toolbar.

◊	 Type the word you are looking for.

6.2 Replacing Text

◊	 Press Ctrl + H to open the Find & Replace dialog.

◊	 Enter the word to find and the replacement text.

◊	 Click “Replace” or “Replace All.”

◊	

◊	

◊	

7.	 Inserting Special Characters

A special character is one not found on a standard English keyboard. For example, © 
¾ æ ç ñ ö ø ¢ are all special characters. Special characters such as the Rupee symbol (₹), 
copyright marks (©), and mathematical symbols can enhance the clarity and precision 
of your documents. To insert a special character, place the cursor where you want it to 
appear and navigate to the Insert menu. Select Special Character from the options and 
choose the desired symbol from the dialog box that appears.

For example, a small electronics repair shop creating invoices can use the ₹ symbol 
to denote prices. By inserting special characters, the shop can ensure clarity and 
professionalism in its documents.

Self-Learning Exercise:

A nano business preparing a catalogue might want to replace the word “offer” 
with “sale” in multiple places. Use this feature to make the edits quickly and 
consistently.

Inserting Special Character:

5.	 Place the cursor where you want to insert the character.

6.	 Go to Insert > Special Character.

7.	 Choose the character and click OK.SG
O
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                                                            Figure 2.2.9

NOTE: Different fonts include different special characters. If you do not find a particular 
special character, try changing the Font selection.

8.	 Formatting Paragraphs

Formatting paragraphs helps in improving the readability and presentation of your 
document. OpenOffice Writer offers options to align text to the left, right, or centre, 
or to justify it for an even alignment across the page. You can also adjust line spacing, 
indentation, and margins to achieve a polished look. For example, if you are preparing a 
product list for a small business, you can use bold headings for product names and align 
descriptions neatly for better visual appeal.

Imagine a tailoring business creating an advertisement. The owner can centre-align 
the heading, justify the body text for a neat appearance, and increase the line spacing 
for better readability. Adding proper formatting makes the document visually appealing 
and easier to read.

You can apply many formats to paragraphs using the buttons on the Formatting 
toolbar. The Formatting toolbar as a floating toolbar, is customised to show only 
the icons for paragraph formatting. The appearance of the icons may vary with your 
operating system and the selection of icon size and style are in Tools > Options > 
OpenOffice > View.

      

                                                       Figure 2.2.10
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8.1 Formatting Characters

You can apply many formats to characters using the buttons on the Formatting 
toolbar. Figure shows the Formatting toolbar, customized to include only the icon for 
character formatting.

The appearance of the icons may vary with your operating system and the selection 
of icon size and style in Tools > Options > OpenOffice > View.

                                                          Figure 2.2.11

8.2 Auto Formatting

You can set Writer to automatically format parts of a document according to the 
choices made on the Options page of the AutoCorrect dialog (Tools > AutoCorrect 
Options)

Some common unwanted or unexpected formatting changes include:

◊	 Horizontal lines. If you type three or more hyphens (---), underscores (___) or 
equal signs (===) on a line and then press Enter, the paragraph is replaced by a 
horizontal line as wide as the page. The line is actually the lower border of the 
preceding paragraph.

◊	 Bulleted and numbered lists. A bulleted list is created when you type a hyphen 
(-), star (*), or plus sign (+), followed by a space or tab at the beginning of a 
paragraph. A numbered list is created when you type a number followed by a 
period (.), followed by a space or tab at the beginning of a paragraph. Automatic 
numbering is only applied to paragraphs formatted with the Default, Text body 
or Text body indent paragraph styles.

To turn auto-formatting on or off, choose Format > AutoCorrect and select or deselect 
the items on the list.

9.	 Hyphenating Words

Hyphenation is a feature that breaks long words at the end of a line, improving the 
alignment and appearance of text. To enable hyphenation, go to the Tools menu, select 
Language, and choose Hyphenation. Writer will suggest hyphenation points, which you 
can accept or modify as needed. This feature is especially helpful for documents with 
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justified alignment, as it ensures even spacing between words. 

For example, a local news bulletin creator working on a community newsletter 
can use hyphenation to make columns look more professional and balanced. Proper 
hyphenation avoids awkward spaces and enhances the layout.

9.1 Automatic Hyphenation

To turn automatic hyphenation of words on or off:

1.	 Press F11 to open the Styles and Formatting window or go to the Styles deck of 
the Sidebar.

2.	 On the Paragraph Styles page, right-click on Default and select Modify.
     
   

   
 
 
  

           

           
              
                                                    Figure 2.2.12

3.	 On the Paragraph Style dialog, go to the Text Flow page.
 

                                                         Figure 2.2.13

4.	 Under Hyphenation, select or deselect the Automatically option. Click OK to 
save.

You can also set hyphenation choices through Tools > Options > Language Settings 
> Writing Aids. In Options, near the bottom of the dialog, scroll down to find the 
hyphenation settings.
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                                                     Figure 2.2.14

To change the minimum number of characters for hyphenation, the minimum number 
of characters before a line break, or the minimum number of characters after a line 
break, select the item, and then click the Edit button in the Options section.

Hyphenation options set on the Writing Aids dialog are effective only if hyphenation 
is turned on through paragraph styles.
9.2 Manual Hyphenation

To manually hyphenate words, do not use a normal hyphen, which will remain 
visible even if the word is no longer at the end of a line when you add or delete text or 
change margins or font size. Instead, use a conditional hyphen, which is visible only 
when required.

To insert a conditional hyphen inside a word, click where you want the hyphen to 
appear and press Ctrl+ - (hyphen). The word will be hyphenated at this position when 
it is at the end of the line, even if automatic hyphenation for this paragraph is switched 
off.

Summarising the above:  To enable Hyphenation:

◊	 Go to Tools > Language > Hyphenation and enable it.

◊	 Writer will automatically suggest hyphenation points.

10.	 Linking to Another Part of a Document

In larger documents, linking to another section can make navigation easier for 
readers. To create a link, select the text you want to use as a hyperlink, right-click, 
and choose the Hyperlink option. In the dialog box, select Document and specify the 
section or page to which the link should direct. This is particularly useful for creating 
interactive tables of contents in reports or manuals.

Type in cross-references to other parts of a document. Those references can easily 
get out of date if you reorganise the order of topics, add or remove material, or reword 
a heading. Writer provides two ways to ensure that your references are up-to-date, by 
inserting links to other parts of the same document or to a different document:

◊	 Hyperlinks

◊	 Cross-references
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The two methods have the same result if you Control+click the link when the document 
is open in Writer: you are taken directly to the cross-referenced item. However, they 
also have major differences:

◊	 The text in a hyperlink does not automatically update if you change the text of 
the linked item (although you can change it manually), but changed text does 
automatically update in a cross-reference.

◊	 When using a hyperlink, you do not have a choice of the content of the link 
(for example text or page number), but when using a cross-reference, you have 
several choices, including bookmarks.

◊	 To hyperlink to an object such as a graphic, and have the hyperlink show useful 
text, you need to either give such an object a useful name instead of leaving 
it as the default name (Graphics6), or you need to use the Hyperlink dialog to 
modify the visible text. In contrast, cross-references to figures with captions 
automatically show useful text, and you have a choice of several variations of 
the name.

◊	 If you save a Writer document to HTML, hyperlinks remain active, but cross-
references do not. (Both remain active when the document is exported to PDF.)

Example Scenario:

Linking helps create an interactive table of contents for a business report.

11.	 Working with Hyperlinks

Adding hyperlinks to your document allows you to connect to external websites, 
email addresses, or other files. To insert a hyperlink, highlight the text or object you 
want to link, go to the Insert menu, and select Hyperlink. Enter the URL or file path in 
the dialog box and click Apply. This feature is ideal for referencing online resources or 
providing additional information in your document.

The easiest way to insert a hyperlink to another part of the same document is by 
using the Navigator:

1.	 Open the document containing the items you want to cross-reference.

2.	 Open the Navigator by clicking its icon, going to the Navigator deck in the 
Sidebar, choosing View > Navigator, or pressing F5.

To Link another part of a document:

5.	 Select the text you want to link.

6.	 Right-click and choose “Hyperlink.”

7.	 In the dialog box, select “Document” and specify the 
target section.
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3.	 Click the arrow next to the Drag Mode icon and choose Insert as Hyperlink.

4.	 In the list at the bottom of the Navigator, select the document containing the 
item that you want to cross-reference.

5.	 In the Navigator list, select the item that you want to insert as a hyperlink.

6.	 Drag the item to where you want to insert the hyperlink in the document. The 
name of the item is inserted in the document as an active hyperlink.

You can also use the Hyperlink dialog to insert and modify hyperlinks within and 
between documents.

                               

 

      

                                                   Figure 2.2.15

Summary of Key Shortcuts
                                           Table 2.2.1

Action Shortcut

Cut Ctrl + X

Copy Ctrl + C
Paste Ctrl + V

Find Ctrl + F

Save Ctrl + S
Replace Ctrl + H

       

To Hyperlink a file path or URL:

1.	 Highlight the text or object you want to 
hyperlink.

2.	 Go to Insert > Hyperlink.

3.	 Enter the URL or file path and click Apply.
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OpenOffice Writer is a versatile and user-friendly word-processing tool that 
empowers users to create professional and visually appealing documents. From typing 
and editing text to formatting paragraphs and adding hyperlinks, Writer provides a wide 
range of features to cater to academic, personal, and business needs. Its open-source 
nature makes it especially beneficial for students, nano businesses, and startups looking 
for cost-effective solutions.

By practising the concepts and exercises in this chapter, you can confidently use 
Writer to draft reports, create promotional materials, and organise your ideas efficiently. 
As you continue to explore Writer, you’ll discover more advanced features that can 
further enhance your productivity and creativity. Start small, experiment with different 
tools, and let Writer become your go-to application for all your document needs.

◊	 OpenOffice Writer is a free, open-source word processor suitable for creating 
and editing text documents.

◊	 Key Features: Offers tools for formatting, inserting images, hyperlinks, and 
creating tables and charts.

◊	 Menu Bar: Provides document-wide commands like Open, Save, and 
Export.

◊	 Status Bar: Displays page numbers, language, and zoom options for better 
navigation.

◊	 Applications: Used by nano businesses for flyers, invoices, and promotional 
materials.

◊	 Advantages: Cost-effective, user-friendly, and compatible with multiple file 
formats.

◊	 Practical Use: Facilitates document creation for academic, personal, and 
business purposes.

Recap

1.	 What is OpenOffice Writer?

2.	 Which file formats does Writer support?

3.	 Name one feature of the status bar in Writer.

4.	 How can you create a hyperlink in Writer?

5.	 What shortcut is used to cut text?

Objective QuestionsSG
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6.	 Which menu contains the “Find and Replace” tool?

7.	 What feature helps improve text alignment using hyphenation?

8.	 Which keyboard shortcut opens the Find toolbar?

9.	 Name a use case for OpenOffice Writer in nano businesses.

10.	 Which menu is used to insert images in a document?

11.	 What type of software is OpenOffice Writer?

12.	 How can you add a special character like ₹?

1.	 A word processor

2.	 DOC, DOCX, ODT

3.	 Page number display

4.	 Insert > Hyperlink

5.	 Ctrl + X

6.	 Edit

7.	 Hyphenation

8.	 Ctrl + F

9.	 Creating flyers

10.	 Insert menu

11.	 Open-source software

12.	 Insert > Special Character

Answers
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1.	 Explain the main features and advantages of OpenOffice Writer for nano 
businesses.

2.	 How does the “Find and Replace” tool enhance document editing? Provide 
an example.

3.	 Describe the process of formatting paragraphs in OpenOffice Writer.

4.	 Discuss how to create and manage hyperlinks within a document in Writer.

5.	 Highlight the practical applications of OpenOffice Writer in creating 
business documents.

6.	 Create an advertisement for a nano business (e.g., a tailoring shop or bakery). 
Include a heading, body text, and contact information. Use different fonts 
and alignments to enhance the layout.

7.	 Prepare a price list for a small business (e.g., a grocery store). Insert special 
characters like ₹ and format the text for clarity.

8.	 Write a one-page essay on a topic of your choice. Use “Find and Replace” 
to modify specific terms in your essay.

9.	 Add hyperlinks to a document: link one section to another and include 
external links to a website or email address.

Assignments

1.	 Cain, N. C. (2012). OpenOffice 3.4 Volume I: Writer. CreateSpace 
Independent Publishing.

2.	 Steinberg, J. (2013). Apache OpenOffice.org 3.4: Using Writer. CreateSpace 
Independent Publishing.
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BLOCK

3
Introduction 
to MS Word
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Upon completion of this unit, learners will be able to;

◊	 explain the purpose, features, and history of Microsoft Word

◊	 identify and use key interface components such as the Ribbon, Quick Access 
Toolbar, and Document Area

◊	 apply essential and advanced editing techniques to create, format, and 
manage professional documents

Learning Outcomes

Imagine you’re a student who wants to write a neat, professional-looking 
assignment or create a stunning project report. Doing it by hand would take time, 
and editing would be difficult if you made mistakes. What if there was a tool that 
allowed you to type, organise, and beautify your content easily while also letting 
you correct errors instantly? That’s where Microsoft Word (MS Word) comes in.

Think of MS Word as your virtual notebook. When you open MS Word, it’s like 
opening a brand-new notebook with endless pages, ready for you to start typing 
your ideas right away. It offers formatting options that feel like using a magical 
pen, allowing you to make your writing bold, colourful, or bigger instantly. If you 
need to underline or italicise something, it’s just a click away. Additionally, MS 
Word enables you to enhance your work with visual elements like pictures, charts, 
or tables, much like sticking images or diagrams into a notebook, but without 
the hassle of glue and scissors. If you make a mistake, there’s no need for an 
eraser—press “Backspace” or “Delete.” The tool also helps with organisation, 
allowing you to create a table of contents automatically, number your pages, and 
align your document neatly. Furthermore, MS Word makes collaboration easy by 
letting you share your document with friends or teachers, who can add comments 
or suggestions directly to your work. It’s a powerful tool that combines creativity, 
convenience, and efficiency in one place.

In this unit, we are learning about MS Word in detail.

Prerequisite

Unit 
1 Introduction 
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 3.1.1 Microsoft Word 
Microsoft Word is a word processing program that has become the industry 

standard for creating and editing digital documents. As part of the Microsoft 
Office suite (now also called Microsoft 365), it offers a comprehensive set of tools 
that allow users to create everything from simple letters to complex reports and 
academic papers.

At its core, Word provides essential text editing capabilities that let users type, 
delete, copy, paste, and move text with ease. The program includes powerful spelling 
and grammar-checking features that help users produce error-free documents. 
Modern versions also incorporate AI-powered suggestions that can help improve 
writing style and clarity. These tools work seamlessly in the background, providing 
real-time feedback as you write.

The program’s formatting capabilities are extensive, allowing users to customise 
how their documents look and feel. Users can choose from hundreds of fonts, 
adjust text size and colour, create custom styles, and organise information using 
bullets and numbering. Page layout tools help control margins, spacing, and overall 
document structure, ensuring professional-looking results that can be consistently 
reproduced when printed or shared digitally.

Word goes beyond basic text handling by providing tools to insert and manage 
various types of content. Users can add tables to organise data, insert pictures 
and charts to illustrate concepts and create headers and footers for professional 
documentation. The software also includes features for creating automated tables of 
contents, managing citations, and generating bibliographies, making it particularly 
valuable for academic and professional writing.

Collaboration has become increasingly important in modern workplaces, and Word 
has evolved to meet this need. The program now includes robust tools for tracking 
changes, adding comments, and working simultaneously with multiple authors on 
the same document. Through integration with cloud storage and Microsoft’s online 
services, users can easily share documents and work together in real-time, regardless 
of their physical location.

The software is available across multiple platforms, including Windows, Mac, 
mobile devices, and web browsers, allowing users to access their documents from 
virtually anywhere. This cross-platform availability, combined with regular updates 

Word Processing, Ribbon Interface, Formatting, Collaboration, Accessibility, 
Microsoft Word

Keywords

Discussion
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and improvements, has helped maintain Word’s position as the leading word-processing 
software in both professional and personal contexts.

3.1.2 History of Microsoft Word
Microsoft Word, often referred to simply as MS Word, is a powerful word-processing 

software that has evolved significantly since its inception. Here is a brief timeline of its 
development:

1.	 Origins (1981–1983)

Microsoft Word began its journey in 1981 when Microsoft hired Charles Simonyi, a 
computer programmer who had worked on the first WYSIWYG (What You See Is What 
You Get) word processor called Bravo at Xerox PARC. Simonyi and his colleague 
Richard Brodie developed the first version of Microsoft Word, initially known as 
“Multi-Tool Word.” The program aimed to provide users with advanced text-editing 
capabilities.

In 1983, Microsoft officially launched Microsoft Word 1.0 for MS-DOS. Unlike 
other text editors of its time, Word introduced revolutionary features like:

◊	 WYSIWYG display: WYSIWYG stands for “What You See Is What You Get” 
and refers to a display or editor that allows users to see a close approximation of 
the final output while they are working on it. In simpler terms, what you see on 
the screen while creating or editing content will closely match the final product, 
whether it’s a document, webpage, or graphic.

◊	 The ability to use a mouse for cursor movement and text selection.

◊	 Support for rich text formatting.

2.	 Early Growth (1985–1990)

In 1985, Microsoft released the first version of Word for the Macintosh. This version 
became popular among Mac users due to its user-friendly interface and integration with 
graphical capabilities.

By 1989, Microsoft introduced Word for Windows (Word 1.0), designed to work on 
the Microsoft Windows operating system. This marked a turning point, as the rise of 
graphical user interfaces (GUIs) made Word more accessible and intuitive for general 
users.

3.	 The Dominance Era (1990s)

The 1990s saw Microsoft Word becoming the standard in word processing:

◊	 Word 2.0 for Windows (1991): Improved speed, stability, and introduced 
features like tables and grammar checking.

◊	 Word 6.0 (1993): Unified the naming conventions for both Windows and Mac 
versions, making it easier for users to work across platforms.
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◊	 Microsoft Word became part of the Microsoft Office Suite, alongside Excel and 
PowerPoint. This bundling strategy cemented its popularity, as businesses and 
schools adopted the suite widely.

4.	 Modernization and New Features (2000–2010)

Microsoft continued refining Word in the 2000s, introducing several groundbreaking 
features:

◊	 Word 2000: Added web integration and better collaboration tools.

◊	 Word 2003: Introduced document protection features, improved formatting, and 
XML support.

◊	 Word 2007: A major overhaul with the introduction of the Ribbon Interface, 
replacing traditional menus and toolbars. It also introduced the .docx file format, 
which was more efficient and compatible with modern standards.

5.	 Cloud Integration and Collaboration (2010–2013)

With the rise of cloud computing, Microsoft Word transformed into a collaborative 
tool:

◊	 Word 2010: Improved integration with cloud services through OneDrive and 
enhanced collaboration features.

◊	 Word 2013: Introduced real-time co-authoring, allowing multiple users to work 
on the same document simultaneously.

◊	 Word 2016 and 2019: Focused on improving accessibility, offering advanced 
editing tools like translator features, and enhancing compatibility with mobile 
devices.

◊	 Word Online: A free, browser-based version of Word that allows users to create 
and edit documents directly on the web.

6.	 Word in the Modern Era

2013: The release of Microsoft 365

Microsoft 365, a new software delivery model for IT users, was unveiled by 
Microsoft in 2013. Access to a collection of programs and applications, including 
Microsoft Word, is provided by the subscription-based service Microsoft 365. Get 
the most recent program versions, ongoing software updates, and cloud-based storage 
choices to backup your work many times by using this service.

2014: cross-device real-time cooperation

Microsoft recognised the increasing demand for co-authoring, real-time editing, 
and collaboration while on the go. In 2014, Microsoft Word enabled many users from 
various smart devices to collaborate on a document at the same time. With your PCs, 
laptops, smartphones, tablets, and more, the new mobile app enabled you to take 
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advantage of smooth collaboration, increased productivity, and improved workflow 
from any location.3.

2015: sharing that is integrated

In 2015, Microsoft made it simpler to share documents with friends, family, 
coworkers, and others. Word included a Share pane that let you submit a document 
straight from the app as a PDF or as an attachment. To ensure you have a backup, attach 
it as a file to your email or upload it to other Microsoft 365 programs, such as “One 
Drive.”

2016: more rapid investigation

Microsoft introduced the Smart Lookup function in 2016 to give you quicker methods 
to search information and gain insights without ever leaving Word.5. You may quickly 
search for specific words or phrases in your document with this robust tool. Save time 
when writing and conducting research by having immediate access to material from 
search engines, online dictionaries, and other web-based sources.

2017: different approaches to reading

With Read Aloud, Microsoft expanded its accessibility features in 2017.6. You might 
listen to your device read aloud your documents thanks to this built-in capability. In 
order to give you additional reading options and customisations, like text spacing, font 
selections, and page backdrop colours, Microsoft also introduced Immersive Reader.7. 
Users who are blind, have impaired vision, or prefer audio-based reading can benefit 
from these innovative reading aids.

2018: animated visuals

An animated 3D graphics capability was added to Microsoft Word in 2018 to 
assist make your writings stand out. Incorporate pulsating hearts, planets in orbit, and 
additional imaginative images into your work. You can alter the behaviour and look of 
the visuals you use by using the library of pre-made animations and effects. Engage 
your readers with an engaging and dynamic reading experience.

2019: increased focus

Microsoft created many modes to help you use Word more effectively because it 
understands how crucial it is for you to maintain focus whether you’re at work, school, 
or finishing your everyday duties. Microsoft Word revived the well-liked Focus Mode 
in 2019. Common Focus Mode To reduce distractions and improve focus, Focus Mode 
conceals all of your device’s menus and toolbars.

2020: Integration with Microsoft Teams

Microsoft sought to make it simple to interact and cooperate without opening 
numerous windows because remote work and online co-authoring were becoming 
more and more popular in 2020. You and your colleagues can now write, design, and 
edit documents in real time within a single application thanks to Microsoft Teams’ 
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integration of Word.10. Businesses, educational institutions, and various households 
were able to collaborate, maintain attention, and complete activities while they were 
apart thanks to this.

2021: writing driven by AI

In 2021, Microsoft Word added text prediction and carried on improving AI-powered 
authoring features. Adding content with polished grammar, a similar style, inclusive 
language, and strategies to increase clarity was made easier with the use of this program. 
This function can provide you creative advice on what to write next if you want more 
detailed recommendations before publishing your document.

2022: Increased privacy and security

Microsoft has consistently added strong security features to Word because it 
understands how crucial data privacy and security are. Microsoft Defender integration, 
multi-factor authentication (MFA), and improved encryption are some of the newest 
features. To protect your personal information and data, these enhanced security features 
offer real-time defence against malware, phishing attempts, and other cybersecurity 
threats.

Today, Microsoft Word is part of the Microsoft 365 subscription service, which 
offers seamless integration across devices and platforms. It includes advanced features 
such as AI-powered suggestions, templates for professional document creation, and 
collaboration tools for remote work and education.

From its humble beginnings as a basic text editor to its current role as an industry-
standard word processor, Microsoft Word has evolved over four decades to meet users’ 
changing needs. Its continuous innovation, ease of use, and integration with other 
Microsoft products have ensured its place as a cornerstone of productivity software 
worldwide.

3.1.3 Navigate in Microsoft Word 365
Main Interface Elements

The Main Interface elements consist of the following:

1.	 Quick Access Toolbar

2.	 Ribbon Interface

3.	 Document Area

4.	 Status Bar

5.	 Navigation Pane
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                                                Figure 3.1.1 

3.1.3.1 Quick Access Toolbar (QAT)

The Quick Access Toolbar (QAT) is located at the top of the Word window, typically 
above or below the Ribbon. It provides one-click access to your most frequently used 
commands.

                                                      Figure 3.1.2
The default QAT includes these essential commands:

1.	 Save (💾)

2.	 Undo (↩)

3.	 Redo (↪)
A.	 Customizing the QAT

Method 1: Direct Addition

1.	 Click the dropdown arrow (▼) at the end of the QAT
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2.	 Select/de-select commands from the menu: 

◊	 New

◊	 Open

◊	 Quick Print

◊	 Print Preview

◊	 Spelling & Grammar

◊	 Full Screen Reading

                                                       Figure 3.1.3
Method 2: From the Ribbon

1.	 Right-click any command in the Ribbon

2.	 Select “Add to Quick Access Toolbar”

                                                        Figure 3.1.4
Method 3: Word Options

1.	 Click File → Options → Quick Access Toolbar

2.	 Choose commands from: 

◊	 Popular Commands

◊	 Commands Not in the Ribbon
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◊	 All Commands

◊	 Macros

◊	 Office Add-ins

                                                         Figure 3.1.5

B.	 Organizing the QAT

◊	 Use arrows to reorder commands

◊	 Create groups with separators

◊	 Move QAT above/below the Ribbon

Keyboard Shortcuts

Access QAT commands using Alt + number:

◊	 Alt + 1: First command

◊	 Alt + 2: Second command

Importing/Exporting QAT Settings

1.	 Go to Word Options → Quick Access Toolbar

2.	 Use Import/Export button to: 

◊	 Back up your customizations

◊	 Share settings with colleagues

◊	 Transfer settings to another computer
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3.1.3.2 The Ribbon Interface

The Ribbon was first introduced in Microsoft Office 2007 and has since become 
a staple feature in subsequent versions. It replaced the traditional menu and toolbar 
system, offering a more visually appealing and organized interface. The Ribbon is 
divided into tabs, each containing groups of related commands and functions. This 
layout makes it easier to locate specific tools and features, saving users valuable time 
and effort. With the Ribbon, users can quickly access commonly used commands and 
customize the interface to suit their individual needs, resulting in a more efficient and 
streamlined workflow.

The Ribbon is divided into logical tabs such as Home Tab, Insert Tab, Layout Tab, 
Navigation Pane.

a.	 Home Tab: It contains the most frequently used commands:

◊	 Font formatting

◊	 Paragraph settings

◊	 Styles

◊	 Editing tools

     

                                                   Figure 3.1.6
b.	 Insert Tab

Show Image For adding elements to your document:

◊	 Tables

◊	 Pictures

◊	 Charts

◊	 Headers and Footers

◊	 Page Numbers
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                                                     Figure 3.1.7

c.	 Layout Tab: Controls document appearance:

◊	 Margins

◊	 Page Orientation

◊	 Columns

◊	 Page Breaks

◊	 Paragraph Spacing

                                                      Figure 3.1.8

3.1.3.3 Document Area

The Document Area is your main workspace where you interact with your content. 
It’s designed to give you a clear view of how your document will appear when finished 
while providing all the tools needed for editing.

◊	 Working Space: The central area where you create and edit your document 

◊	 Margins: Visual guides showing printable area 

◊	 Rulers: Horizontal and vertical rulers for alignment (toggle with View → Show 
→Rulers) 

◊	 Scroll Bars: Vertical and horizontal bars for navigation
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                                                        Figure 3.1.9

Common View Options

Show Image Access through the View tab or status bar:

1.	 Read Mode

2.	 Print Layout

3.	 Web Layout

4.	 Outline View

5.	 Draft View

                                                      Figure 3.1.10

3.1.3.4 Navigation Pane

The Navigation Pane is essential for working with longer documents, making it easy 
to move between sections and find specific content quickly.

Access the Navigation Pane through:
1.	 Ctrl + F shortcut

2.	 View tab → Show group → Navigation Pane checkbox
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3.	 Search box at the top of the screen

The Navigation Pane has three tabs:

1.	 Headings: Shows document structure

2.	 Pages: Displays page thumbnails

3.	 Results: Shows search results

                                                    Figure 3.1.11

3.1.3.5 Status Bar Features

The Status Bar acts as your command centre for important document information 
and quick actions. It’s highly customizable and can show exactly the information you 
need for your workflow.

1.	 Page number and count

2.	 Word count

3.	 Proofing status

4.	 Language

5.	 View options

6.	 Zoom sliderSG
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                                                    Figure 3.1.12

Note: Put the following (Navigation shortcut, Selection Shortcut and mouse tips) in 
Stand Alone Box – for layout team

Navigation Shortcuts
                                             

  Table 3.1.1

Shortcut Action
Ctrl + ← / → Move by word
Ctrl + ↑ / ↓ Move by paragraph
Home / End Start/end of line
Ctrl + Home/End Start/end of document
Page Up/Down Move up/down one screen

Selection Shortcuts
                                            

 Table 3.1.2

Shortcut Action
Shift + Arrow keys Select text
Ctrl + A Select all
Shift + Ctrl + Arrow keys Select by word
F8 Start selection mode
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Mouse Navigation Tips

◊	 Single click: Position cursor

◊	 Double click: Select word

◊	 Triple click: Select paragraph

◊	 Click in left margin: Select line

◊	 Drag in left margin: Select multiple line

3.1.4 Create and Save Word Documents
All documents are based on templates. When you create a “blank” document that 

document is based on the default Normal template in word.  One can create a blank 
document of the default type or create a document with a pre-defined design, such as 
one of the other templates provided with word. Each non-blank template incorporates 
specific design elements such as fonts and colours.

3.1.4.1 Creating New Documents

                                                       Figure 3.1.13
Method 1: From Start Screen

1.	 Open Word

2.	 Click “Blank document” or

3.	 Choose a template from: 

◊	 Featured templates

◊	 Search online templates

◊	 Personal templates

Method 2: Within Word

1.	 File → New
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2.	 Select from: 

◊	 Blank document (Ctrl + N)

◊	 Recent templates

◊	 Custom templates

3.1.4.2 Saving Documents

First Save

1.	 Click Save icon (💾) or press Ctrl + S

2.	 Choose location: 

◊	 OneDrive (cloud storage)

◊	 This PC

◊	 Browse for more locations

Save Options

◊	 Save As: Create new copy (Ctrl + Shift + S)

◊	 AutoSave: Automatic cloud saving

◊	 Recover Unsaved: Find unsaved documents

File Formats

◊	 .docx (default)

◊	 .doc (compatibility mode)

◊	 .pdf

◊	 .rtf

◊	 .txt

3.1.5 Managing Your Workspace

                                                       Figure 3.1.14
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3.1.5.1 Window Management

1.	 View Multiple Documents 

◊	 View → Window → Arrange All

◊	 Switch Windows

◊	 New Window

2.	 Split Screen 

◊	 View → Split

◊	 Drag split bar

◊	 Remove split

3.1.5.2 Customizing Workspace

1.	 View Options 

◊	 Zoom level

◊	 Page width

◊	 Show/hide rulers

◊	 Show/hide gridlines

2.	 Display Settings 

◊	 Dark/Light mode

◊	 Reading mode

◊	 Print layout

◊	 Web layout

3.1.6 Editing Documents

3.1.6.1 Basic Editing

1.	 Text Operations 

◊	 Type to insert

◊	 Backspace/Delete to remove

◊	 Cut (Ctrl + X)

◊	 Copy (Ctrl + C)
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◊	 Paste (Ctrl + V)

2.	 Selection Techniques 

◊	 Click and drag

◊	 Double-click: Select word

◊	 Triple-click: Select paragraph

◊	 Ctrl + A: Select all

3.1.6.2 Advanced Editing

1.	 Find and Replace 

◊	 Ctrl + F: Find

◊	 Ctrl + H: Replace

◊	 Advanced options: 

	f Match case

	f Whole words

	f Wildcards
2.	 Format Painter 

◊	 Single click: One-time use

◊	 Double click: Multiple uses

◊	 Clear formatting

3.1.6.3 Track Changes

1.	 Turn on Track Changes

2.	 Show markup options

3.	 Accept/Reject changes

4.	 Compare documentsSG
O
U



        SGOU - SLM -  UG - AC Course - Software For Office Management96

                                                    Figure 3.1.15

3.1.7 Formatting Text and Paragraphs

3.1.7.1 Character Formatting

Basic Font Options

1.	 Font Selection 

◊	 Font type

◊	 Size

◊	 Colour

Best Practices

1.	 Regular Saving 

◊	 Enable AutoSave

◊	 Create backup copies

◊	 Use version history

2.	 Document Organization 

◊	 Use consistent naming

◊	 Create folder structure

◊	 Use tags and properties

3.	 Editing Efficiency 

◊	 Learn keyboard shortcuts

◊	 Use Quick Access Toolbar

◊	 Customize ribbon for your needs
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◊	 Highlight

2.	 Text Effects 

◊	 Bold (Ctrl + B)

◊	 Italic (Ctrl + I)

◊	 Underline (Ctrl + U)

◊	 Strikethrough

◊	 Subscript

◊	 Superscript

                                                     Figure 3.1.16

3.	 Advanced Font Options 

◊	 Character spacing

◊	 Text effects and typography

◊	 OpenType features

◊	 Ligatures

◊	 Stylistic sets

3.1.7.2 Paragraph Layout

Alignment Options

◊	 Left (Ctrl + L)

◊	 Center (Ctrl + E)

◊	 Right (Ctrl + R)

◊	 Justify (Ctrl + J)

Spacing Controls

1.	 Line Spacing 

◊	 Single
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◊	 1.5 lines

◊	 Double

◊	 Multiple

◊	 Exact

◊	 At least

2.	 Paragraph Spacing 

◊	 Before paragraph

◊	 After paragraph

◊	 First line indent

◊	 Hanging indent

Indentation

◊	 Left indent

◊	 Right indent

◊	 First line indent

◊	 Hanging indent

◊	 Mirror indents

3.1.7.3 Tab Settings

Tab Types

1.	 Left Tab: Text extends right

2.	 Center Tab: Text centers on position

3.	 Right Tab: Text extends left

4.	 Decimal Tab: Aligns numbers on decimal point

5.	 Bar Tab: Vertical line position

Tab Management

◊	 Set tab positions

◊	 Set default tab stops

◊	 Add leader lines

◊	 Clear tabs
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3.1.8 Managing and Formatting Lists in Microsoft Word

3.1.8.1 Types of Lists

1.	 Bulleted Lists

◊	 Default bullets (•, ○, ■)

◊	 Custom bullets

◊	 Picture bullets

◊	 Multi-level bullets

2.	 Numbered Lists

◊	 Arabic numbers (1, 2, 3)

◊	 Letters (a, b, c or A, B, C)

◊	 Roman numerals (i, ii, iii or I, II, III)

◊	  Custom numbering

  
           

  

  

                                              Figure 3.1.17

3.	 Multi-level Lists

◊	 Outline numbering

◊	 Mixed format lists

◊	 Custom hierarchy

3.1.8.2 Sorting Lists

Basic Sorting

1.	 Sort Text 

◊	 Alphabetical (A to Z)
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◊	 Reverse alphabetical (Z to A)

◊	 Select list

◊	 Home → Paragraph → Sort button

2.	 Sort Numbers 

◊	 Ascending order

◊	 Descending order

◊	 Custom sequences

Advanced Sorting

1.	 Multiple Criteria 

◊	 Primary sort

◊	 Secondary sort

◊	 Tertiary sort

2.	 Special Sort Options 

◊	 Case sensitive

◊	 Headers

◊	 Languages

◊	 Custom lists

List Formatting

Bullet Formatting

1.	 Change Bullet Style 

◊	 Select from library

◊	 Define new bullet

◊	 Picture bullet

◊	 Font symbols

2.	 Bullet Position 

◊	 Alignment

◊	 Indentation
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◊	 Text position

◊	 Hanging indent

Number Formatting

1.	 Number Style 

◊	 Format: 1), A), i)

◊	 Separator options

◊	 Start value

◊	 Continue from previous

2.	 Number Position 

◊	 Left alignment

◊	 Right alignment

◊	 Follow by options

◊	 Text indentation

Multi-level List Formatting

1.	 Level Management 

◊	 Define level format

◊	 Link levels

◊	 Level indents

◊	 Number position

2.	 Style Connection 

◊	 Connect to styles

◊	 Update automatically

Essential Shortcuts

◊	 Alt + H, N: Start numbered list

◊	 Alt + H, U: Start bulleted list

◊	 Tab: Increase level

◊	 Shift + Tab: Decrease level

◊	 Ctrl + Shift + L: Apply multi-level list
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Advanced Techniques

Custom List Features

1.	 Define Custom Lists 

◊	 Create new list format

◊	 Save list templates

◊	 Modify existing lists

◊	 Share list formats

2.	 List Styles 

◊	 Create list styles

◊	 Modify list styles

◊	 Apply consistently

◊	 Update automatically

Tips and Best Practices

Format Consistency

1.	 Use Styles 

◊	 Create custom styles

◊	 Update styles

◊	 Copy styles

2.	 Format Painter 

◊	 Single use

◊	 Multiple use

◊	 Clear formatting

 Keyboard Shortcuts

Show Image

◊	 Ctrl + Shift + >: Increase font size

◊	 Ctrl + Shift + <: Decrease font size

◊	 Ctrl + Space: Remove manual formatting

◊	 Ctrl + Q: Remove paragraph formatting
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 Advanced Techniques

1.	 Format by Example 

◊	 Select text with desired format

◊	 Use format painter

◊	 Apply to multiple selections

2.	 Clear Formatting 

◊	 Select text

◊	 Ctrl + Space

◊	 Clear All Formatting button

◊	 Introduction to MS Word: Overview of the features, importance, and 
utility of Microsoft Word.

◊	 Interface Navigation: Quick Access Toolbar, Ribbon, Document Area, and 
Navigation Pane explained.

◊	 Document Creation: Methods for creating, saving, and managing 
documents effectively.

◊	 Editing Tools: Basic and advanced editing techniques, including Find and 
Replace and Track Changes.

◊	 Formatting: Customizing text, paragraphs, and lists for a professional 
appearance.

◊	 Collaboration: Real-time co-authoring and cloud integration.

◊	 Publishing Documents: Tools for checking spelling, grammar, and 
accessibility, and saving in different formats.

Recap

1.	 What is the default file format for Word documents?

2.	 Which feature allows real-time collaboration in Word?

3.	 What shortcut is used to save a document?

Objective QuestionsSG
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4.	 Name the tool used to create automated tables of contents.

5.	 Which shortcut opens the Navigation Pane?

6.	 What feature tracks changes made to a document?

7.	 Which tab contains the page orientation option?

8.	 Name the file format used for older versions of Word.

9.	 What is the function of the Ribbon in MS Word?

10.	 Which shortcut applies bold formatting to text?

11.	 What tool is used for alignment in a document?

12.	 Name the pane used to search within a Word document.

1.	 .docx

2.	 Co-authoring

3.	 Ctrl + S

4.	 References tab

5.	 Ctrl + F

6.	 Track Changes

7.	 Layout Tab

8.	 .doc

9.	 Interface for tools

10.	 Ctrl + B

11.	 Ruler

12.	 Navigation Pane

Answers
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1.	 Discuss the evolution and key milestones in the history of Microsoft Word.

2.	 Explain the role and customization options of the Quick Access Toolbar.

3.	 Describe the Ribbon Interface and its significance in Word processing.

4.	 What are the steps to create a table of contents automatically in Word?

5.	 How can Microsoft Word enhance collaboration and improve accessibility 
in documents?

6.	 Open MS Word and identify the Ribbon, QAT, and Navigation Pane, 
explaining their functionality.

7.	 Create a professional document using various formatting tools like headings, 
bullets, and tables.

8.	 Share a document via OneDrive, allowing collaborators to add comments 
and track changes.

9.	 Create a multi-section document and generate an automated table of 
contents.

10.	 Draft a document, then use Word’s accessibility checker to identify and fix 
any issues.

Assignments

1.	 Lambert, J., & Frye, C. (2021). Microsoft Word step by step (Office 2021 
and Microsoft 365). Microsoft Press.

2.	 Basham, S. (2021). Microsoft Word in easy steps: Covers MS Word in Office 
365 suite. In Easy Steps Limited.

Suggested Reading
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1.	 Habroken, J. (2021). Microsoft Office inside out (Office 2021 and Microsoft 
365). Pearson Education.

2.	 Foulkes, L. (2020). Learn Microsoft Office 2019: A comprehensive guide to 
getting started with Word, PowerPoint, Excel, Access, and Outlook. Packt 
Publishing

Reference
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After the completion of this unit, the learner will be able to;

◊	 identify and use tools in MS Word to enhance document quality

◊	 comprehend the importance of spelling, grammar, and readability checks

◊	 utilise research tools to ensure credible information

◊	 ensure documents are accessible and correctly formatted for sharing

Learning Outcomes

Consider Jane, a history student preparing her dissertation. She needs to check 
for spelling mistakes, ensure her grammar is accurate, verify her references, and 
make sure her document is accessible to everyone, including her professor who 
uses screen-reading software. By following a systematic process in MS Word, Jane 
can transform her draft into a professional document ready for submission. This 
guide will walk you through the steps she might take, ensuring your documents are 
equally polished and impactful.

In this unit, we will learn the final steps in publishing documents. Publishing a 
document involves ensuring that it is polished, professional, and accessible to your 
audience. This provides key steps to help you prepare your document effectively.

Prerequisite

Unit 
2 Publishing Document 

Spelling, Grammar, Accessibility, Researcher, Flesch Reading Ease, PDF, Alt 
Text

KeywordsSG
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 3.2.1 Preparing to Publish a Document
Publishing a document is the final step in creating professional, polished 

materials ready for sharing or distribution. Imagine you’re a university student 
tasked with submitting a project report. You’ve completed your research and 
written your content, but before you hit “send” or print it out, you need to ensure 
the document meets high standards of quality, accessibility, and readability. Using 
tools in MS Word, you can refine your work, correct errors, and format it to suit 
your audience.

 3.2.1.1 Check Spelling

Spelling errors can make your document look unprofessional and distract your 
readers. Follow these steps to check spelling:

1.	 Navigate to the Review tab in the ribbon at the top of MS Word.

2.	 Click on Spelling & Grammar. This will open a pane or a dialog box 
highlighting spelling errors.

3.	 Carefully review the flagged words and the suggested corrections. Use your 
discretion, as some suggestions may not apply, such as proper nouns or 
technical terms.

4.	 Additionally, manually proofread the document to catch any errors the spell 
checker might miss.

3.2.1.2 Grammar and Readability

Grammar and readability play a key role in ensuring your document is easy to 
understand. Use the following methods to improve these aspects:

1.	 Use the built-in Grammar Checker in MS Word, located in the Review tab. 
The checker flags grammar issues and provides suggestions for corrections.

2.	 For enhanced readability:

◊	 Navigate to File > Options > Proofing.

◊	 Ensure that the Show readability statistics option is checked under the 
section “When correcting spelling and grammar in Word.”

3.	 After running a spelling and grammar check, Word will display readability 
statistics, such as the Flesch Reading Ease score and Flesch-Kincaid Grade 
Level. Aim for a readability level suitable for undergraduate learners.

Discussion
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4.	 Simplify sentences that are too complex and avoid unnecessary jargon unless 
required for the audience’s understanding.

3.2.1.3 Use Research Tools

Accurate and credible information strengthens your document. MS Word offers tools 
to assist with research:

1.	 Open the References tab.

2.	 Click on Researcher, a tool that allows you to search for reliable sources without 
leaving the document.

3.	 In the Researcher pane, type the topic you wish to explore. A list of sources will 
appear.

4.	 Select the desired source and insert relevant citations directly into your document 
using the Citations & Bibliography feature.

5.	 Ensure that all inserted information is verified for accuracy.

3.2.1.4 Check Accessibility

Ensuring accessibility makes your document usable for everyone, including those 
with disabilities. Follow these steps:

1.	 In the Review tab, click on Check Accessibility.

2.	 A pane will open, listing potential accessibility issues such as:

◊	 Missing alt text for images.

◊	 Insufficient colour contrast.

◊	 Improper use of headings.

3.	 Resolve these issues by:

◊	 Adding alt text: Right-click on an image, select Edit Alt Text, and provide a 
brief but descriptive explanation of the image.

◊	 Adjust font styles and colours to ensure clear contrast and readability.

4.	 To improve document structure, use clear font and size and proper headings 
(e.g., Heading 1, Heading 2).

3.2.1.5 Save a Document to Other Formats

Saving your document in different formats allows for better sharing and accessibility. 
Common formats include:
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1.	 PDF (Portable Document Format)

◊	 Preserves the layout and formatting.

◊	 To save as a PDF, go to File > Save As, and select PDF from the Save as type 
dropdown menu.

2.	 Plain Text (TXT)

◊	 Removes all formatting, ensuring compatibility with basic text editors.

◊	 Save as TXT through the Save As dialog.

3.	 HTML (Hypertext Markup Language) (Web Page)

◊	 Suitable for web publishing.

◊	 Save as HTML by selecting Web Page from the Save as type dropdown menu.

4.	 Always review the saved document in the new format to ensure that formatting 
and layout remain consistent.

By following these steps, you can prepare a polished and professional document. 
Remember, the key to an impactful document lies in its clarity, accuracy, and accessibility.

◊	 Spelling Check: Ensure your document is free of spelling errors using MS 
Word’s built-in tools.

◊	 Grammar and Readability: Simplify sentences and enhance readability 
using the grammar checker and readability statistics.

◊	 Research Tools: Find and cite reliable sources directly in MS Word.

◊	 Accessibility: Make your document accessible to all, including users with 
disabilities.

◊	 Save in Multiple Formats: Convert your document to PDF, TXT, or HTML 
for varied purposes.

Recap

1.	 Where can you find the Spelling & Grammar tool in MS Word?

2.	 What does the Accessibility Checker highlight?

3.	 What is the full form of PDF?

Objective QuestionsSG
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4.	 Which tab contains the Researcher tool?

5.	 What does Flesch Reading Ease measure?

6.	 How can you add alt text to an image?

7.	 Which file format is ideal for web publishing?

8.	 What is the purpose of the Citations & Bibliography feature?

9.	 Where can you enable readability statistics in MS Word?

10.	 Name one key feature of saving a document as Plain Text.

11.	 How can you ensure proper contrast in a document?

12.	 What is the benefit of saving a document as a PDF?

1.	 Review Tab

2.	 Potential accessibility issues

3.	 Portable Document Format

4.	 References Tab

5.	 Readability of the text

6.	 Right-click > Edit Alt Text

7.	 HTML

8.	 Insert citations

9.	 File > Options > Proofing

10.	 Compatibility with basic text editors

11.	 Adjust font styles and colours

12.	 Preserves layout and formatting

Answers

SG
O
U



        SGOU - SLM -  UG - AC Course - Software For Office Management112

1.	 Explain the steps to check spelling and grammar in MS Word.

2.	 Describe how to improve the readability of a document using MS Word.

3.	 How can you use the Researcher tool to strengthen the credibility of your 
document?

4.	 What steps can you take to ensure your document is accessible to all users?

5.	 Discuss the advantages of saving a document in different formats.

6.	 Create a document with intentional spelling errors and correct them using 
the Spelling & Grammar tool.

7.	 Write a 200-word passage and use the readability statistics to analyse its 
suitability for undergraduate learners.

8.	 Use the Researcher tool to find three sources on a given topic and insert 
citations into a document.

9.	 Check a sample document for accessibility issues and resolve them using 
the Accessibility Checker.

10.	 Save a sample document in PDF, TXT, and HTML formats and compare the 
formatting in each.

Assignments

1.	 Lambert, J., & Frye, C. (2021). Microsoft Word step by step (Office 2021 
and Microsoft 365). Microsoft Press.

2.	 Basham, S. (2021). Microsoft Word in easy steps: Covers MS Word in Office 
365 suite. In Easy Steps Limited.

Suggested Reading
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1.	 Habroken, J. (2021). Microsoft Office inside out (Office 2021 and Microsoft 
365). Pearson Education.

2.	 Foulkes, L. (2020). Learn Microsoft Office 2019: A comprehensive guide to 
getting started with Word, PowerPoint, Excel, Access, and Outlook. Packt 
Publishing

Reference
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BLOCK

4
MS EXCEL
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Upon the completion of this Unit, the learner will be able to;

◊	 comprehend the basic structure and navigation of Microsoft Excel, including 
worksheets and workbooks

◊	 demonstrate the ability to input, organise, and manipulate data within Excel

◊	 apply data visualisation techniques such as creating and formatting charts 
for analysing business data

◊	 utilise advanced Excel functionalities such as importing data, managing 
tables, and automating tasks to streamline small business operations

Learning Outcomes

Imagine you are starting a handmade soap business. Microsoft Excel can help 
you maintain detailed records of:

◊	 Raw Material Purchases: Tracking the quantity and cost of ingredients 
such as essential oils, soap bases, and packaging materials.

◊	 Daily Sales Records: Logging the number of soaps sold each day, customer 
names, and payment methods.

◊	 Inventory Management: Monitoring stock levels to ensure timely restocking 
and avoid shortages.

◊	 Customer Feedback and Orders: Recording customer preferences, special 
orders, and complaints to improve product quality.

◊	 Expense and Revenue Analysis: Analysing business profits by comparing 
costs and sales revenue over different periods.

Similarly, consider a small organic farming business that grows vegetables and 
sells them at a local farmer’s market. Using Excel, the farmer can:

◊	 Maintain a crop production calendar, tracking sowing and harvesting 
schedules.

Prerequisite

Unit 
1

Worksheets and Work 
Books 
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◊	 Record sales data, categorizing earnings by vegetable type and peak seasons.

◊	 Analyse fertilizer and pesticide costs to optimise spending.

◊	 Track customer preferences, identifying which vegetables sell the most during 
different months.

◊	 Forecast future production needs based on past trends, ensuring consistent 
supply without wastage.

By applying Excel to real-world nano business scenarios, students can gain hands-on 
experience in managing operations efficiently.

 4.1.1 Introduction  
Microsoft Excel is a widely used spreadsheet application developed by 

Microsoft, designed for data management, analysis, and visualisation. It allows 
users to perform calculations, organise information, create tables, generate charts, 
and automate tasks using formulas and functions. Excel is essential for businesses, 
students, and professionals who need to work with structured data efficiently. 
Its powerful tools enable users to analyse trends, manage financial records, and 
create reports with ease. Microsoft Excel is a powerful tool widely used for data 
management, analysis, and visualisation. It consists of a grid structure made up 
of rows and columns, where users can input and manipulate data. Excel provides 
essential features such as formulas, functions, pivot tables, and charts, making it 
an invaluable tool for businesses and academics alike.

Excel is commonly used in financial modelling, budgeting, inventory tracking, 
and project management. It offers automation capabilities through macros and 
Visual Basic for Applications (VBA), reducing manual effort in repetitive tasks. 
Additionally, features like conditional formatting, data validation, and collaboration 
tools enhance productivity.

For small business owners, Excel is an essential tool for tracking sales, managing 
expenses, and analysing customer data. It's ability to import and export data from 
various sources makes it a flexible and versatile application for any professional 
environment. Mastering Excel can significantly enhance one’s ability to organise 
data, perform calculations, and present business insights effectively. This learning 
material will introduce key Excel functionalities using practical examples related 

Microsoft Excel, Workbook and Worksheet, Data Management, Nano Business 
Operations, Data Visualization

Keywords

Discussion
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to nano business enterprises, helping students develop essential skills for business 
operations.

4.1.2 Getting Started with Microsoft Excel: A Simple Guide 
for Beginners 

Microsoft Excel is a spread sheet programme used to record and analyse numerical 
and statistical data. It provides multiple features to perform various operations like 
calculations, pivot tables, graph tools etc…It is compatible with multiple operating 
systems like Windows, Mac OS. Android and ios.

4.1.2.1 Installing Microsoft Excel

Before using Excel, you need to install the software on your computer. Microsoft 
Excel is available as part of the Microsoft 365 suite or as a standalone application. 
Follow these steps to install it:

1.	 Purchase or Subscribe: Visit Microsoft’s official website and choose a suitable 
Microsoft 365 plan. There is also a free online version with limited features.

2.	 Download the Installer: After purchasing / selecting appropriate installer tool, 
download the Microsoft 365 setup file.

3.	 Run the Installer: Open the downloaded file and follow the on-screen 
instructions. You may need to log in with your Microsoft account.

4.	 Activate Excel: Once installed, launch Excel and activate it using your Microsoft 
365 subscription or product key.

5.	 Update the Software: Ensure that you have the latest updates by going to “File” 
> “Account” > “Update Options” > “Update Now.”

If you are using a mobile device, you can install Excel from the Apple App Store or 
Google Play Store.

Practical Work Assignment: Download and install Excel on your computer. Open 
the application and explore the interface, including the Ribbon, Formula Bar, and 
Worksheet area.

4.1.2.2 Opening Excel and Creating New Workbooks

To begin using Excel, first the Excel software must be installed in your desktop / 
laptop or operating system (as the case may be). 

Open the software from the Start menu or desktop shortcut. Once launched, you 
can start with a blank workbook by selecting “New Workbook.” A workbook is a 
collection of worksheets where data is stored and analysed. For instance, if you own a 
small handmade jewellery business, you can create a workbook titled “Jewellery Sales 
Report” to track daily sales, expenses, and inventory.
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                                                       Figure 4.1.1

Microsoft Excel ribbon is the row of tabs and icons at the top of the Excel window 
that allows you to quickly find, understand and use commands for completing a certain 
task. It looks like a complex toolbar, which it is.

◊	 Ribbon tab contains multiple commands logically sub-divided into groups.

◊	 Ribbon group is a set of closely related commands normally performed as part 
of a larger task.

◊	 Dialog launcher is a small arrow in the lower-right corner of a group that brings 
up more related commands. Dialog launchers appear in groups that contain 
more commands than available space.

◊	 Command button is the button you click to perform a particular action.

                          

     

                                                    Figure 4.1.2
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Partially Hiding and Unhiding the Ribbon can be done in five different ways!

Ribbon shortcut. The fastest way to hide Excel ribbon is to press Ctrl + F1.

1.	 Double-click a tab. The ribbon can also be collapsed by double-clicking an 
active tab.

2.	 Arrow button. Another quick way to hide the ribbon in Excel is to click the up 
arrow in the lower-right corner of the ribbon.

                                            

                            

                                                Figure 4.1.3

3.	 Pop-up menu. In Excel 2013, 2016, and 2019,

4.	 Right-click anywhere on the ribbon and select Collapse the Ribbon from the 
context menu. In Excel 2010 and 2007, this option is called Minimize the 
Ribbon.

                         

                                                     Figure 4.1.4

5.	 Ribbon Display Options. Click the Ribbon Display Options icon.

                        

                                                  
Figure 4.1.5
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When saving a workbook, choose an appropriate file name and location to ensure 
easy retrieval. Excel files are typically saved with a .xlsx extension. You can also save a 
file in different formats, such as .csv for compatibility with other applications.

Practical Work Assignment: Open Excel, create a new workbook for a small business 
idea of your choice, and save it with a relevant name.

4.1.2.3  Selecting Cells and Importing Data

In Excel, data is entered into cells, which are arranged in a grid of rows and 
columns. Selecting cells is essential for applying formulas, formatting, and organizing 
information. You can select individual cells by clicking on them or multiple cells by 
dragging the mouse over a range.

The Cell is the smallest unit in Excel. The cell is used to store data. Excel is comprised 
of rows (↔) and columns (↕). The rows are represented as numbers (1, 2, 3,), and the 
columns as letters. To reference a specific cell in Excel, we will type its column letter, 
followed by the row number. So, A1 will be the first cell in your worksheet – It is in the 
first column (A), and in the first row (1):

                                                    Figure 4.1.6

Entering Text: To Enter text or a number in a cell, click a cell, type the numbers, or 
text that you want to enter, and then press ENTER or TAB. To enter data on a new line 
within a cell, enter a line break by pressing Alt + ENTER

In Microsoft Excel, a range is a collection of cells. These cells can be in the same 
row, the same column, or even in different rows and columns. Place the mouse cursor 
over a cell, press and hold down the left mouse button, then move the mouse while still 
holding down the left mouse button.

You can also select a group of nearby cells using Shift button. Click on a cell and 
then, while holding Shift, select the other cell diagonally. (as shown below)

Shortcut Key: Press Ctrl + N to create a new workbook.
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                                                           Figure 4.1.7

Each range is represented by two cells – The top-left cell, and the bottom-right cell, 
separated with colons (:).

Importing of Data

Excel allows users to import data from various sources, including text files, Excel 
files, Word documents, and even the web. This feature is particularly useful for nano 
businesses that need to consolidate data from different sources into a single worksheet 
for better analysis.

Importing Data from a Text File

Nano business owners often store transaction details in text files exported from 
payment apps or POS systems. To import this data into Excel, open the spreadsheet 
where you want the data to appear. Click on the Data tab, then select from Text/CSV 
under the Get & Transform Data group. Locate and select the text file you want to 
import, then click Import. The Text Import Wizard will guide you through formatting 
options, such as selecting delimiters (commas, tabs, etc.). Once you’ve configured these 
settings, click Finish to complete the process.

Importing Data from Another Excel File

If a nano business maintains separate Excel files for different operations, such as one 
for inventory and another for sales, these files may need to be combined. To do this, 
navigate to Data > Get External Data, then click Browse to locate the file. Choose how 
the data should be stored (as a table or linked workbook), then click OK to import.

Importing Data from a Word Document

Sometimes, business contracts or customer lists are stored in Word documents. To 
import data, save the Word document, then open Excel and click Data > From Text/
CSV. Select the Word document, make necessary changes, then click Load to import 
the data into the spreadsheet.

Shortcut Key: Press Ctrl + A to select all cells.
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                                                       Figure 4.1.8

Importing Data from the Web

Many nano businesses rely on external market data, such as commodity prices or 
industry trends, which can be imported directly from websites. To do this, open Excel, 
click Data, then Get & Transform > From Web. Copy and paste the URL containing the 
data, then follow the prompts to import it into Excel.

    

  

                                                  Figure 4.1.9

Practical Work Assignment:

1.	 Download a sample text file containing sales records and import it into Excel.

2.	 Create two Excel files—one for customer orders and another for inventory—
and import one into the other.

3.	 Copy market trend data from a website and import it into Excel using the web 

Shortcut Key for Importing Data: Alt + A + R + TSG
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import feature.

By mastering data importation, students can efficiently integrate external data sources 
into Excel, making it a valuable tool for business management.

4.1.2.4 Adding a Worksheet to an Existing Workbook

A workbook can contain multiple worksheets to manage different sets of data. To add 
a worksheet, click the “+” icon next to existing sheets. You can rename worksheets by 
double-clicking the tab and entering a meaningful name.

     

  

                                                     Figure 4.1.10

For example, if you run a nano business selling handmade soaps, one worksheet can 
track raw material purchases, another can maintain customer orders, and a third can 
analyse monthly revenue trends. Organizing data into separate sheets makes business 
analysis more efficient.

Practical Work Assignment: Add and organize multiple worksheets for sales, 
expenses, and customer feedback in a single workbook.

4.1.2.5 Copying and Moving a Worksheet

If you need to duplicate the content of one worksheet to another, Excel allows you 

Shortcut Key: Press Shift + F11 to insert a new worksheet.SG
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to copy an existing worksheet. To duplicate data, right-click on a worksheet tab and 
select “Move or Copy.” Check the “Create a copy” box if you want to retain the original 
sheet while creating a duplicate. Dragging a sheet tab to a new location reorders the 
worksheets.

                                    

  

                                            Figure 4.1.11

The Move or Copy dialog box will appear. Choose where the sheet will appear in the 
Before sheet: field. In our example, we’ll choose (move to end) to place the worksheet 
to the right of the existing worksheet. Check the box next to Create a copy, then click 
OK.

                   

   

                                              Figure 4.1.12
For example, if you are a nano business owner of textile shop, and you are collating 

the sales and revenue for your business, then this feature is useful when you want 
to forecast the next quarter’s sales based on current data. Copying an existing sales 
worksheet allows you to modify values without affecting the original.
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4.1.2.6 Moving a Worksheet

Sometimes you may want to move a worksheet to rearrange your workbook.

◊	 Select the worksheet you wish to move. The cursor will become a small 
worksheet icon .

◊	 Hold and drag the mouse until a small black arrow appears above the desired 
location.

              

                                                     Figure 4.1.13

◊	 Release the mouse. The worksheet will be moved

◊	

Practical Work Assignment: Copy an existing worksheet and modify data to simulate 
business growth projections.

4.1.2.7 Inserting and Deleting Columns or Rows

In order to insert a column or row, all you have to do is to click on  “Insert”. Let’s 
see an example. If you are managing a bakery’s sales sheet and while entering the 
weekdays, one of the weekday “Fridays” got missed. Let’s see how we can insert the 
column without re-writing the entire sheet. 

◊	 Here are the seven days of the week. But Friday is missing!

          

                                                  Figure 4.1.14

◊	 To add a column between D and E, you have to Right Click on the “E” Column 
and select the Insert!

            

Shortcut Key: Press Ctrl + Drag to copy a worksheet.
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                                                      Figure 4.1.15

◊	 This will create a new “E” column and will move everything to the right!

           

                                                       Figure 4.1.16

Alternatively, you can use the insert command on the Home Tab as given below and 
may insert the column where needed. The new column will appear to the left of the 
selected column

                      
                       

                                                    Figure 4.1.17

The same can be done for Rows too! 

To add multiple rows or columns in a spreadsheet, highlight the same number of pre 
existing rows or columns that you want to add. Then, right-click and select “Insert.”
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                                             Figure 4.1.18

Like inserting the same thing can be done for delete option as well. Instead of 
selecting Insert, in the same menu, you may select delete option to remove or delete the 
required row or column.

                      

                  

                                                      Figure 4.1.19

Practical Work Assignment: Insert and delete rows or columns to optimize a product 
pricing sheet.

4.1.2.8 Changing Workbook Themes

Excel allows you to change themes to create visually appealing reports. Under the 
“Page Layout” tab, select “Themes” to modify fonts, colours, and effects. A consistent 
theme ensures uniformity across reports.

You can change a worksheet’s colour to help organize your worksheets and make 
your workbook easier to navigate. The steps can be summarised as below:

1.	 Right-click the desired worksheet and hover the mouse over Tab Colour. The 
Colour menu will appear.

2.	 Select the desired colour. A live preview of the new worksheet colour will 

Shortcut Key: Press Ctrl + Shift + “=” to insert a row or column, and Ctrl + “-” to 
delete.
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appear as you hover the mouse over different options. In our example, we’ll 
choose Red. The worksheet colour will be changed.

                             

       

                                                      Figure 4.1.20

The worksheet colour is considerably less noticeable when the worksheet is selected. 
As an exercise, select another worksheet to see how the colour will appear when the 
worksheet is not selected.

                     

                                                    Figure 4.1.21

For instance, using such a professional theme enhances readability and impact while 
presenting a financial summary to potential investors for a micro-financing project.

Practical Work Assignment: Apply a professional theme to enhance the presentation 
of a financial report.

4.1.2.9 Adjusting Row Height and Column Width

By default, every row and column of a new workbook is always set to the same 
height and width. Excel allows you to modify column width and row height in different 
ways, including wrapping text and merging cells. Sometimes, text does not fit within a 
cell. 

To modify column width

1.	 Position the mouse over the column line in the column heading so the white 

Shortcut Key: No direct shortcut; use the “Page Layout” tab manually.
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cross  becomes a double arrow 

2.	 Click, hold, and drag the mouse to increase or decrease the column width

3.	 Release the mouse. The column width will be changed

       

                                                           Figure 4.1.22

To AutoFit column width
The AutoFit feature will allow you to set a column’s width to fit its content 

automatically.

1.	 Position the mouse over the column line in the column heading so the white 
cross becomes a double arrow. 

2.	 Double-click the mouse. The column width will be changed automatically to fit 
the content.

Alternatively, you can also AutoFit the width for several columns at the same time. 
Simply select the columns you would like to AutoFit, then select the AutoFit Column 
Width command from the Format drop- down menu on the Home tab. This method can 
also be used for Row height.

                                   

                                                 Figure 4.1.23

Similar method needs to be adopted for adjusting the height of the Row as well. 

If a clothing boutique maintains an inventory list with long product descriptions, 
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adjusting column width ensures that all details remain visible.

Practical Work Assignment: Adjust column width to properly display product 
descriptions in an inventory sheet.

4.1.2.10 Inserting Headers and Footers

Adding headers and footers makes printed documents more professional. Navigate 
to “Insert” > “Header & Footer” and include relevant details such as company name, 
page numbers, or report titles.

Select the worksheet where you want to add or change headers or footers. Go 
to Insert > Header & Footer. Excel displays the worksheet in Page Layout view

             

                                                         
Figure 4.1.24

       
   

   

                                                      Figure 4.1.25

After selecting Header & Footer Tab, a new command page will open up displaying 
the options that can be used for header and footer, respectively.

Shortcut Key: Press Alt + H + O + W to adjust column width.
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                                                       Figure 4.1.26

For a nano business presenting an expense report to a bank for a small loan, inserting 
a header with the business name and date ensures clarity and brings in professional 
approach.

Practical Work Assignment: Insert a header and footer in a business proposal 
document.

4.1.2.11 Creating and Managing Tables

Tables in Excel are an essential feature for organizing and analysing data efficiently. 
By converting a range of data into a table, users can easily manage large sets of 
information while taking advantage of features like sorting, filtering, and automatic 
formatting. For nano businesses, Excel tables help in managing inventory, tracking 
sales, and organizing customer data effectively.

To create a table, first enter the data in a structured manner with headers for each 
column. Then, select any cell within the data range and navigate to the Insert tab. Click 
on Table, and Excel will automatically detect the data range.

      

                                                    Figure 4.1.27

Shortcut Key: Press Alt + N + H to insert a header/footer.
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Confirm the selection and check the box for My table has headers if applicable.

                 

                                                   Figure 4.1.28

Once the table is created, it becomes easier to manipulate data with built-in filters 
and quick formatting options.

      

                                                        Figure 4.1.29
Alternatively, you can select a range of data and click “Format as Table” under 

the “Home” tab. This feature allows for easy sorting and filtering, making it easier to 
analyse and manage business information. This also brings in an aesthetic approach to 
your data presentation.SG
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                                                    Figure 4.1.30

Managing tables involves various functions, including adding new rows or columns, 
deleting unnecessary entries, and modifying formatting to enhance readability. Excel 
also provides structured references, allowing users to use table column names in 
formulas instead of traditional cell references. This feature simplifies calculations and 
makes formulas more understandable.

For nano businesses, creating tables can significantly improve data organization. 
For example, a home-based candle-making business can maintain a table to track raw 
material purchases, sales transactions, and customer preferences. The table might 
include columns for product type, purchase date, supplier details, cost, and stock 
availability. By using table features like sorting and filtering, the business owner can 
quickly analyse sales trends, identify popular products, and ensure timely re-stocking 
of materials.

A practical exercise for students would be to create a table for a fictional nano 
business. Suppose a small online clothing boutique tracks its inventory using Excel. 
Students can input data such as item name, category, price, quantity in stock, and 
supplier details into a structured table. They can then use sorting and filtering tools to 
identify best-selling items, analyse stock levels, and create simple sales reports using 
Excel’s built-in functions. By mastering table creation and management, students will 
develop crucial skills for handling structured data effectively, which is essential for 
running and analysing small business operations efficiently.

4.1.2.12 Creating and Formatting Charts

Charts are an essential tool in Microsoft Excel that help visualize data, making it 
easier to interpret and analyse trends. For beginners, learning how to create and format 
charts is crucial in presenting business data effectively. Visualizing data helps in better 
decision-making. 

Shortcut Key: Press Ctrl + T to create a table.SG
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A chart in Excel is a graphical representation of data that allows users to analyse 
patterns and relationships more effectively than raw numbers alone. Excel offers a 
variety of chart types, including bar charts, line charts, pie charts, and column charts. 
The choice of chart depends on the nature of the data and the message it aims to convey.

For instance, a nano business enterprise, such as a homemade soap-making business, 
may need to analyse its monthly sales performance. Instead of scanning a table filled 
with numbers, a bar or line chart can instantly highlight sales trends and seasonal 
fluctuations, helping the business owner make informed decisions.
Creating a Chart in Excel

To create a chart, one must first have well-structured data. Suppose a homemade 
soap business tracks its monthly sales revenue. The data might be organized as follows:

                                               Table 4.1.1

Month Sales Revenue (INR)
January 15,000
February 18,000
March 22,000
April 20,000
May 25,000
June 30,000

To create a chart, the user should follow these steps:

1.	 Open Microsoft Excel and enter the data into a worksheet.

2.	 Select the data range, including the column headers (e.g., A1:B7).

3.	 Navigate to the “Insert” tab and choose a suitable chart type from the “Charts” 
group.

4.	 Click on the chosen chart type, such as a column or line chart, and Excel will 
generate the chart instantly.

      

                                                             Figure 4.1.31
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Formatting the Chart for Better Visualization

Once a chart is created, formatting enhances its readability and aesthetic appeal. 
Formatting options include adding a title, labelling axes, changing colours, and 
modifying chart styles.

To make the chart visually effective for the homemade soap business, the following 
customizations can be applied:

◊	 Adding a Title: Click on the chart, go to the “Chart Tools” tab, select “Chart 
Title,” and type “Monthly Sales Performance.”

◊	 Labelling Axes: Click on “Axis Titles” under “Chart Elements” and label the 
x-axis as “Months” and the y-axis as “Sales Revenue (INR).”

◊	 Changing Colours: Select the chart, go to “Chart Styles,” and choose a colour 
scheme that is easy on the eyes yet contrasts well with the data.

◊	 Adding Data Labels: Data labels help in quickly identifying the exact values 
for each data point. Right-click on a data point, select “Add Data Labels,” and 
Excel will display the corresponding values.

           

                                                      

                                                      Figure 4.1.32

Mastering chart creation and formatting in Excel is a vital skill for analysing and 
presenting data efficiently. By practicing with real-world business examples, such 
as those from nano enterprises, beginners can develop a solid foundation in data 
visualization. The ability to transform raw numbers into meaningful insights will be 
beneficial in both academic and professional settings.

Practical Exercise for Learners

To reinforce learning, leaners can practice creating and formatting a chart based on 
the following scenario:

A nano business enterprise producing organic candles wants to track its quarterly 

Shortcut Key: Press Alt + F1 to insert a default chart.SG
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sales across four regions: North, South, East, and West. The data is as follows:
                                                     

Table 4.1.2

Region Q1 Sales (INR) Q2 Sales (INR) Q3 Sales (INR) Q4 Sales (INR)

North 10,000 12,000 15,000 18,000
South 8,000 9,500 12,000 14,500
East 9,000 10,500 13,000 16,000
West 11,000 13,500 16,500 19,000

Students should follow these steps to create a stacked column chart:

1.	 Open a new Excel worksheet and enter the above data.

2.	 Select the data range (A1:E5).

3.	 Click on the “Insert” tab and choose “Stacked Column Chart.”

4.	 Add appropriate chart elements, including a title, axis labels, and data labels.

5.	 Customize the colour scheme to differentiate between quarters clearly.

By practicing these tasks, students can develop a strong foundation in Excel, making 
them proficient in handling data for small business enterprises. Excel’s features can 
greatly enhance business efficiency, from managing finances to analysing customer 
trends and helping young entrepreneurs make informed decisions.

◊	 Introduction to Excel: Explanation of Excel’s purpose, such as data 
management, analysis, and visualisation.

◊	 Getting Started: Steps to install Excel, create new workbooks, and explore 
the interface.

◊	 Cell Operations: Methods for selecting cells, entering data, and using 
shortcuts.

◊	 Data Importation: Techniques for importing data from text files, Excel files, 
Word documents, and websites.

◊	 Worksheet Management: Adding, moving, and copying worksheets for 
organised data handling.

◊	 Formatting and Themes: Adjusting row/column sizes, applying themes, and 
adding headers/footers for professionalism.

◊	 Tables and Charts: Creating and managing tables and charts to analyse and 
visualise data effectively.

Recap
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1.	 What is the default file extension for Excel files?

2.	 Which shortcut key creates a new workbook in Excel?

3.	 What is the smallest unit in Excel?

4.	 Name the tab used to insert a chart.

5.	 Which Excel feature allows users to apply uniform styles to workbooks?

6.	 What shortcut key is used to insert a new worksheet?

7.	 Name the dialog box used for copying a worksheet.

8.	 How do you auto-adjust column width to fit content?

9.	 Which tab in Excel contains the “Themes” option?

10.	 What is the shortcut for selecting all cells in a worksheet?

11.	 What is the command to insert a header in Excel?

12.	 Which tab provides the “Format as Table” option?

Objective Questions

1.	 .xlsx

2.	 Ctrl + N

3.	 Cell

4.	 Insert

5.	 Themes

6.	 Shift + F11

7.	 Move or Copy

8.	 AutoFit

9.	 Page Layout

10.	 Ctrl + A

Answers
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1.	 Explain the importance of using Microsoft Excel in nano business 
operations.

2.	 Describe the process of importing data from different sources into Excel.

3.	 How do you create and manage tables in Excel? Provide examples.

4.	 What are the steps to create a chart in Excel, and why is it beneficial for 
business analysis?

5.	 Discuss the role of formatting and themes in enhancing the presentation of 
Excel reports.

6.	  Install Excel, open a new workbook, and explore the interface by identifying 
key components such as the ribbon, formula bar, and worksheet area.

7.	 Create a workbook for a small business idea, including worksheets for sales, 
expenses, and customer feedback. Save and organize the workbook.

8.	 Import sales data from a sample text file and analyze it using filters and 
basic formulas.

9.	 Design a table for tracking inventory with columns for product name, stock 
quantity, supplier, and cost.

10.	  Create a bar chart to visualize monthly sales data and format it with titles, 
axis labels, and data labels.

Assignments

11.	 Alt + N + H

12.	 Home
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After the completion of this unit, the learner will be able to;

◊	 develop proficiency in using logical functions like AND, OR, and NOT in 
Microsoft Excel to analyse and manipulate data efficiently

◊	 apply conditional functions such as SUMIFS, AVERAGEIFS, and 
COUNTIFS to generate insights from datasets

◊	 analyse data trends and patterns for informed decision-making in small-scale 
businesses using Excel functions

◊	 solve real-world data problems in nano businesses through practical 
applications of Excel formulas and functions

Learning Outcomes

Consider a nano business enterprise named “Handmade Delights,” which sells 
customised handmade crafts online. The business maintains an Excel sheet to 
track daily sales, product categories, costs, and revenue. The owner wants to use 
logical functions to analyse data effectively and make informed decisions. In this 
unit, let’s learn Excel functionalities, such as entering data into cells, using basic 
formulas, and understanding absolute and relative references in detail.

Prerequisite

Unit 
2

Apply Functions in 
        Formulas 

Logical Functions, Conditional Criteria, SUMIFS, AVERAGEIFS, COUNTIFS
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 4.2.1 Introduction

Microsoft Excel is a powerful tool that enables users to analyse, manipulate, 
and visualize data efficiently. One of the key functionalities of Excel is its ability 
to perform logical operations using functions such as AND, OR, and NOT. 
Additionally, more complex calculations involving conditional criteria can be 
carried out using nested functions like SUMIFS, AVERAGEIFS, and COUNTIFS. 
Understanding these functions is crucial for businesses to filter data, generate 
insights, and make informed decisions.

Logical operations and conditional functions are especially important in 
managing and analysing business data. In a nano business enterprise, where 
resources are limited, efficient data management is essential to track expenses, 
sales, and customer behaviour. This chapter will introduce these functions with 
examples from a small handmade crafts business, demonstrating their practical 
applications.

Understanding and Using Formulas

One of its most significant features is the ability to use formulas to perform 
calculations and automate tasks. Mastering formulas in Excel is essential 
for undergraduate students, particularly those studying commerce, business 
administration, and finance.

A formula in Excel is an expression that calculates values in a cell. Every formula 
begins with an equal sign (=), followed by the desired operation. For example, 
to add two numbers, one would enter “=5+3” in a cell, and Excel would return 
the result “8.” More commonly, formulas reference other cells to create dynamic 
calculations. If a nano business enterprise tracks its monthly sales in column B, the 
total sales for the year so far can be calculated using “=SUM(B2:B7),” where B2 
to B7 represent the sales figures for each month.

                                                   Figure 4.2.1

Discussion
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Finding the right formula can sometimes be a challenge, especially for beginners. 
Excel provides various ways to search for a suitable function. One effective method is 
using the “Insert Function” button, which opens a dialog box allowing users to browse 
functions by category or search by keyword.

      

                                                          Figure 4.2.2

Another approach is typing an equal sign followed by the first few letters of a function 
name in a cell. Excel then provides a list of matching functions in a drop-down menu. 
For instance, a nano business enterprise owner who wants to calculate loan payments 
can type “=AVE” and select the appropriate function to determine average of sales 
revenue received across the year or period.

   

                                                       Figure 4.2.3

Excel formulas are widely used in nano business enterprises to optimize financial 
operations. Suppose a small bakery wants to determine the average revenue 
generated per day. If the daily sales data is recorded in cells B2 to B8, the formula 
“=AVERAGE(B2:B8)” provides the average revenue for the given period.SG
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                                           Figure 4.2.4

Similarly, if a business owner wants to apply a discount to products during a 
promotional campaign, they can use “=B2*0.9” to reduce the price in cell B2 by 10%.

We shall further explore few of critical formula functions in Microsoft Excel which 
can help a nano business to make effective decisions and enable smooth execution of 
business.

4.2.1.1 Understanding the ‘AND’ Function

The AND function in Excel is a logical function used to test multiple conditions 
simultaneously. It returns TRUE if all specified conditions are met and FALSE if at 
least one condition is not met. The function follows the syntax

      =AND(logical1, logical2, ...)

Where logical1, logical2, and so on are the conditions that need to be tested. There 
can be up to 255 logical conditions in a single AND function.

This function is particularly useful in scenarios where multiple criteria must be 
satisfied before a decision is made. Small business owners can leverage this function 
to streamline operations, manage inventory, analyse sales performance, and make data-
driven decisions.

Applying the AND Function in a Nano Business Enterprise

Consider a small retail business selling handmade soaps. The owner wants to identify 
which orders qualify for a discount. The conditions for a discount are:

1.	 The order value must be greater than $100.

2.	 The customer must be a returning buyer.

The Excel formula for this logic would be:

      =AND(A2>100, B2=”Yes”)

If the order value in column A is greater than $100 and the returning customer status 
in column B is “Yes”, the function will return TRUE; otherwise, it will return FALSE. 
This helps the business owner quickly determine which customers are eligible for a 
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discount without manually checking each order.

Further Business Applications of the AND Function

1.	 Inventory Management: A nano business dealing in organic spices might use the 
AND function to determine when to reorder stock. Suppose the reorder condition 
is:

◊	 The stock level is below 20 units.

◊	 The supplier’s next delivery date is more than five days away. The formula to 
check this condition would be

      =AND(A2<20, B2>5)

If both conditions are true, the business owner knows it’s time to reorder.

1.	 Employee Performance Evaluation: A small bakery with a team of five employees 
may want to reward workers who meet both of the following criteria:

◊	 Monthly sales contribution is above $5,000.

◊	 Customer feedback rating is 4.5 stars or higher.

Using Excel, the owner can quickly analyse performance with:

      =AND(A2>5000, B2>=4.5)

Employees who meet both criteria will receive a TRUE result, making it easy to 
identify who deserves an incentive.

Practical Learning Exercise

To reinforce the understanding of the AND function, let’s work through a practical 
exercise.

Scenario: You are managing a small bookstore. Customers qualify for free shipping if:

◊	 Their total purchase is above $50.

◊	 They have a loyalty membership.

You have the following data:
                                                     Table 4.2.1

Order ID Order Value ($) Loyalty Member (Yes/No)

101 75 Yes
102 45 No
103 60 Yes
104 30 Yes
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Task: Use the AND function to create a formula that identifies whether an order qualifies 
for free shipping.

Expected formula:

      =AND(B2>50, C2=”Yes”)

Apply the formula across the dataset and analyse which orders are eligible for free 
shipping.

4.2.1.2 Understanding the OR Function

Similar to AND function, the OR function is also a logical function used to test 
multiple conditions at the same time. It follows the syntax:

      =OR(logical1, logical2, ...)

Here, logical1, logical2, and additional conditions are the logical tests that Excel 
evaluates. If at least one condition is TRUE, the function returns TRUE; otherwise, it 
returns FALSE. The OR function can handle up to 255 conditions, making it highly 
versatile for small businesses that need to analyse different operational aspects.

Applying the OR Function in a Nano Business Enterprise

Consider a small home-based candle-making business that offers a seasonal discount. 
Customers qualify for the discount if:

1.	 Their total purchase is above $75.

2.	 They are first-time buyers.

To implement this logic in Excel, the formula would be:

      =OR(A2>75, B2=”Yes”)

If the total order value in column A exceeds $75 or the customer status in column B is 
marked as “Yes” for first-time buyers, the function returns TRUE, indicating eligibility 
for the discount. Otherwise, it returns FALSE. This simplifies the discount allocation 
process without requiring manual verification.

Further Business Applications of the OR Function

One key advantage of the OR function is its ability to handle flexible criteria, making 
it invaluable for nano business owners managing various aspects of their operations.

For example, in a small online clothing boutique, free shipping may be offered under 
two conditions:

◊	 If the total purchase exceeds $100.

◊	 If the customer has a VIP membership.

The Excel formula for this would be:
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      =OR(A2>100, B2=”VIP”)

This ensures that customers meeting at least one of these conditions receive free 
shipping. The OR function allows for efficient and automatic determination of benefits, 
helping business owners streamline customer service and promotions.

Another example is in an organic vegetable delivery service. Suppose a business 
owner wants to mark deliveries as urgent if:

◊	 The delivery location is outside the city.

◊	 The order includes perishable items.

Using the OR function, the formula would be:

      =OR(A2=”Outside City”, B2=”Perishable”)

This ensures that any order falling into either category is prioritized for quicker 
dispatch, reducing spoilage and improving customer satisfaction.

Practical Learning Exercise

To apply your understanding of the OR function, consider the following exercise.

Scenario: You manage a small bakery and want to identify which orders qualify for 
priority baking. An order qualifies for priority baking if:

◊	 The order total is above $50.

◊	 The customer has placed a special request.

You have the following dataset:
                                                     

Table 4.2.2
Order ID Order Value ($) Special Request (Yes/No)
201 40 Yes
202 55 No
203 30 No
204 70 Yes

Task: Write an Excel formula using the OR function to identify which orders should be 
prioritized for baking.

Expected formula:

      =OR(B2>50, C2=”Yes”)

Apply the formula across the dataset and observe which orders return TRUE, 
indicating they should be prioritized.
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4.2.1.3 Understanding the ‘NOT’ Function

The NOT function in Excel is used to reverse the logical value of a given condition. 
If the condition is TRUE, the NOT function returns FALSE, and if the condition is 
FALSE, it returns TRUE. The syntax for the NOT function is straightforward:

      =NOT(logical)

Where logical is the condition or expression that needs to be reversed. This function 
is particularly useful when business owners want to highlight exceptions, filter data 
based on negation or identify conditions that do not meet specific criteria.

Applying the NOT Function in a Nano Business Enterprise

Consider a small online jewellery business that offers free gift wrapping on all orders 
except those marked as “Wholesale.” The business owner wants to quickly identify 
which orders are not wholesale so that free gift wrapping can be applied. Using the 
NOT function, the Excel formula would be:

      =NOT(A2=”Wholesale”)

In this case, if column A contains “Wholesale,” the formula returns FALSE (indicating 
no gift wrapping). If the order is anything other than wholesale, the formula returns 
TRUE, ensuring that gift wrapping is applied accordingly. This helps automate the 
process and reduces manual errors.

Another example is in a small organic produce delivery business. The owner wants 
to flag customers who have not opted for a weekly subscription so they can be targeted 
for promotional campaigns. The data is stored in a column labelled “Subscription” with 
values “Yes” or “No.” The formula to identify non-subscribers would be:

      =NOT(B2=”Yes”)

If the customer is a subscriber, the function returns FALSE (meaning no need for 
promotional targeting). If they are not a subscriber, the function returns TRUE, ensuring 
they are included in marketing efforts to encourage subscriptions.

In an artisanal coffee shop that requires advance orders for special blends, customers 
who have not pre-ordered should be identified for follow-up reminders. The business 
owner can use:

      =NOT(C2=”Pre-ordered”)

This helps in targeting only those who have not placed an order, ensuring efficient 
inventory management and improving customer engagement.

Practical Learning Exercise

To deepen the understanding of the NOT function, let’s go through a practical 
scenario.

Scenario: You own a small bookstore that offers a special discount to all customers 
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except those who are members of a specific loyalty program. The membership status 
is recorded in a column with “Member” or “Non-Member.” You want to use the NOT 
function to identify customers who are not members so that they can receive the special 
discount.

Your dataset looks like this:
                                                      

   Table 4.2.3
Customer ID Name Membership Status
001 Alice Member
002 Bob Non-Member
003 Carol Member
004 Dave Non-Member

Task: Write an Excel formula using the NOT function to identify customers eligible 
for the discount.

Expected formula:

      =NOT(C2=”Member”)

Apply this formula across the dataset to see which customers return TRUE, indicating 
they qualify for the special discount.

4.2.1.4 Understanding the SUMIFS Function

One of the most useful functions for nano business enterprises is the SUMIFS 
function, which allows users to sum values based on multiple conditions. This function 
is particularly beneficial for small business owners who need to track sales, expenses, 
and other financial metrics while applying specific filters.

The SUMIFS function is designed to sum values that meet multiple criteria. Unlike 
the SUMIF function, which allows for only one condition, SUMIFS can handle multiple 
conditions simultaneously, making it a versatile tool for data analysis. The function 
follows this syntax:

      =SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)

Here, sum range represents the range of values to be added, while criteria_range1, 
criteria1, and additional criteria define the conditions that must be met for a value to be 
included in the sum.

Applying the SUMIFS Function in a Nano Business Enterprise

Consider a small bakery that sells different types of cakes. The owner wants to 
calculate total sales for a specific cake type within a certain date range. Suppose the 
bakery maintains a sales record in an Excel sheet with columns for product type, sale 
date, and revenue. To calculate total revenue from chocolate cakes sold in January, the 
formula would be:
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      =SUMIFS(C2:C100, A2:A100, “Chocolate Cake”, B2:B100, “>=01-Jan-2024”, 
B2:B100, “<=31-Jan-2024”)

This formula sums all values in column C (Revenue) where column A (Product 
Type) matches “Chocolate Cake” and column B (Sale Date) falls between January 
1 and January 31, 2024. This helps the business owner track sales performance for 
specific products within a given timeframe.

Another example is in a home-based handicrafts business where different items are 
sold in various regions. The business owner wants to analyse total revenue generated 
from a particular product in a specific region. If the sales data includes columns for 
product name, region, and sales revenue, the SUMIFS function can help filter and sum 
the data efficiently. The formula:

      =SUMIFS(C2:C500, A2:A500, “Handmade Scarf”, B2:B500, “New York”)

This formula sums the revenue for all “Handmade Scarf” sales occurring in “New 
York” from the dataset, providing valuable insights for regional sales strategies.

Further Business Applications of the SUMIFS Function

In a small café, the owner might want to determine total earnings from customers 
who purchased a specific drink and visited during peak hours. If columns include 
beverage name, time of purchase, and sales revenue, the SUMIFS function can be used 
to analyse customer preferences and revenue trends.

For example, to find total sales of “Cappuccino” between 8 AM and 11 AM:

      =SUMIFS(C2:C300, A2:A300, “Cappuccino”, B2:B300, “>=08:00”, B2:B300, 
“<=11:00”)

This calculation helps in assessing peak-hour sales trends and optimizing inventory 
and staffing accordingly.

Practical Learning Exercise

To reinforce the understanding of the SUMIFS function, consider the following 
scenario.

Scenario: You manage a small bookstore and want to analyse total sales revenue from 
mystery books sold in February. Your data set includes:

                                                         
 Table 4.2.4

Order ID Genre Sale Date Revenue ($)

101 Mystery 05-Feb-2024 25
102 Romance 10-Feb-2024 30
103 Mystery 15-Feb-2024 20
104 Mystery 28-Feb-2024 35
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Task: Use the SUMIFS function to create a formula that calculates the total revenue 
from mystery books sold in February.

Expected formula:

      =SUMIFS(D2:D100, B2:B100, “Mystery”, C2:C100, “>=01-Feb-2024”, 
C2:C100, “<=29-Feb-2024”)

By applying this formula, you can quickly determine the total sales revenue for 
mystery books during February. This knowledge is invaluable for analysing sales trends, 
making informed inventory decisions, and implementing targeted marketing strategies.

4.2.1.5 Understanding the AVERAGEIFS Function

One particularly powerful function is the AVERAGEIFS function, which allows 
business owners to calculate the average of a range of values that meet multiple criteria. 
For nano businesses, where every transaction counts, using AVERAGEIFS can help in 
analysing sales trends, evaluating employee performance, or optimizing operational 
costs with precision.

The AVERAGEIFS function works by computing the average of values that meet 
specific conditions. Its syntax is structured as follows:

      =AVERAGEIFS(average_range, criteria_range1, criteria1, [criteria_range2, 
criteria2], ...)

Here, average_range contains the values that need to be averaged, while criteria_
range1, criteria1, and additional criteria define the conditions that must be met for 
a value to be included in the calculation. This function is particularly useful when 
analysing financial data, sales performance, or any other dataset that requires multi-
condition filtering.

Applying the AVERAGEIFS Function in a Nano Business Enterprise

Consider a small coffee shop that tracks daily beverage sales and customer ratings to 
determine the quality and profitability of different drinks. The owner wants to calculate 
the average price of all “Latte” beverages that received a customer rating of 4 stars 
or higher. The shop maintains a record of sales in an Excel sheet with columns for 
beverage type, price, and customer rating. The formula to calculate the desired average 
price would be:

      =AVERAGEIFS(B2:B100, A2:A100, “Latte”, C2:C100, “>=4”)

This formula averages all values in column B (Price) where column A (Beverage 
Type) matches “Latte” and column C (Customer Rating) is 4 or higher. This helps the 
business owner assess how well higher-rated lattes are priced and whether adjustments 
should be made.

Another practical example involves a small home-based bakery that wants to 
determine the average revenue from chocolate cakes sold in the last month. The bakery 
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keeps a record of all sales, including product type, sale date, and revenue. If the bakery 
owner wants to calculate the average revenue for chocolate cakes sold in March, the 
following formula could be applied:

      =AVERAGEIFS(C2:C200, A2:A200, “Chocolate Cake”, B2:B200, “>=01-Mar-
2024”, B2:B200, “<=31-Mar-2024”)

This formula filters the revenue data in column C where column A (Product Type) 
is “Chocolate Cake” and column B (Sale Date) falls between March 1 and March 31, 
2024. By doing so, the bakery owner can determine the average earnings per sale of 
chocolate cakes during that specific period and make informed pricing and production 
decisions.

Similarly, a nano business offering home tutoring services may want to analyse 
the average hourly rate charged for math lessons in different locations. If the business 
tracks subject type, hourly rate, and location, it can apply the AVERAGEIFS function 
to calculate the average rate for math lessons conducted online as opposed to in-person. 
A formula such as:

      =AVERAGEIFS(B2:B300, A2:A300, “Math”, C2:C300, “Online”)

would return the average hourly rate for online math lessons, helping the tutor decide 
whether to standardize or adjust pricing.

Practical Learning Exercise

To reinforce the understanding of the AVERAGEIFS function, let’s work through a 
hands-on exercise.

Scenario: You manage a small bookstore that sells different genres of books and 
records customer ratings for each sale. You want to calculate the average sale price of 
“Mystery” books that received a customer rating of at least 4. Your dataset includes:
                                                          

  Table 4.2.5
Order ID Genre Sale Price ($) Customer Rating
101 Mystery 25 5
102 Romance 30 4
103 Mystery 20 3
104 Mystery 35 4

Task: Write an Excel formula using the AVERAGEIFS function to find the average sale 
price of “Mystery” books that have a customer rating of 4 or higher.

Expected formula:

      =AVERAGEIFS(C2:C100, B2:B100, “Mystery”, D2:D100, “>=4”)

Apply this formula across your dataset to determine the average price of high-rated 
mystery books. This knowledge can help in setting competitive prices, managing 
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inventory, and understanding customer preferences better. 

4.2.1.6 Understanding the COUNTIFS Function

One of the most useful functions for nano enterprises is the COUNTIFS function, 
which allows users to count the number of entries that meet multiple conditions. This 
function is particularly beneficial for small business owners who need to track inventory, 
analyse sales patterns, and monitor customer behaviour.

The COUNTIFS function is used to count the number of cells that meet multiple 
criteria simultaneously. It follows the syntax:

      =COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2], ...)

Here, criteria_range1 is the range where the first condition is applied, criteria1 is 
the condition to be met, and additional ranges and criteria can be added to refine the 
count further. This function provides a dynamic way to filter and count data, making it 
a valuable tool for business owners.

Applying the COUNTIFS Function in a Nano Business Enterprise

Consider a small homemade soap business that tracks orders in an Excel spreadsheet. 
The business owner wants to count how many orders were placed for “Lavender Soap” 
in the month of March. If the spreadsheet has columns for product type, order date, and 
order status, the following formula can be used:

      =COUNTIFS(A2:A100, “Lavender Soap”, B2:B100, “>=01-Mar-2024”, 
B2:B100, “<=31-Mar-2024”)

This formula counts all orders where column A contains “Lavender Soap” and column 
B contains dates that fall between March 1 and March 31, 2024. This information helps 
the business owner assess the popularity of specific products over a defined time period.

Another example is a small handmade jewellery shop that sells items online. The 
owner wants to count the number of completed orders that were shipped to New York. 
If the spreadsheet contains columns for order status, city, and payment status, the owner 
can use:

      =COUNTIFS(A2:A500, “Completed”, B2:B500, “New York”, C2:C500, “Paid”)

This formula filters and counts only those orders that are marked as “Completed” in 
column A, have “New York” as the shipping city in column B, and have a “Paid” status 
in column C. This allows the owner to monitor order fulfilment effectively and ensure 
all paid orders are processed.

A nano business offering digital marketing services might use the COUNTIFS 
function to track the number of projects completed by different employees within a 
specific timeframe. If the business tracks project type, completion date, and assigned 
employee, the following formula could be applied:

      =COUNTIFS(A2:A300, “SEO Campaign”, B2:B300, “>=01-Jan-2024”, 
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B2:B300, “<=31-Jan-2024”, C2:C300, “John Doe”)

This formula counts the number of SEO campaigns completed in January 2024 by 
John Doe. By using COUNTIFS, business owners can analyse employee performance, 
assess workload distribution, and optimize project assignments.

Practical Learning Exercise

To deepen the understanding of the COUNTIFS function, consider the following 
scenario.

Scenario: You manage a small bookstore and want to analyse how many orders were 
placed for “Fiction” books in February that were marked as “Delivered.” Your dataset 
includes:
                                                      

Table 4.2.6
Order ID Genre Order Date Order Status
201 Fiction 05-Feb-2024 Delivered
202 Mystery 10-Feb-2024 Delivered
203 Fiction 15-Feb-2024 Pending
204 Fiction 28-Feb-2024 Delivered

Task: Write an Excel formula using the COUNTIFS function to find the total number 
of “Fiction” book orders that were marked as “Delivered” in February.

Expected formula:

      =COUNTIFS(B2:B100, “Fiction”, C2:C100, “>=01-Feb-2024”, C2:C100, 
“<=29-Feb-2024”, D2:D100, “Delivered”)

By applying this formula, you can quickly determine how many fiction books were 
successfully delivered during February. This helps in tracking inventory demand, 
improving order management, and ensuring timely fulfilment.

Practical Learning Exercise

Scenario:You own a small artisanal spice business called “Spice Delight”, based in 
India. You sell a variety of premium spices such as turmeric, cardamom, and saffron. 
You track your sales data in an Excel spreadsheet. Your goal is to analyze your sales to 
identify trends, calculate totals, averages, and counts using Excel functions like AND, 
OR, NOT, SUMIFS, AVERAGEIFS, and COUNTIFS.

Below is the sales data for the last 20 transactions. Use it to complete the tasks.

Sales Data:
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Date Product Cate 
gory

Reg 
ion

Units 
Sold

Price 
Per  
Unit 
(₹)

Total 
Sales 
(₹)

Payment 
Method

Cust 
omer  
Rating  
(1-5)

01/01/2025 Turmeric Spices North 5 200 1000 UPI 5
01/02/2025 Cardamom Spices South 2 500 1000 Cash 4

01/03/2025 Saffron Spices West 1 1500 1500 Net 
Banking

5

01/04/2025 Turmeric Spices East 10 180 1800 UPI 3
01/05/2025 Cardamom Spices North 4 450 1800 Cash 5
01/06/2025 Saffron Spices South 2 1400 2800 UPI 4
01/07/2025 Turmeric Spices West 8 190 1520 UPI 4

01/08/2025 Cardamom Spices North 3 500 1500 Credit 
Card

3

01/09/2025 Saffron Spices East 1 1550 1550 UPI 5
01/10/2025 Turmeric Spices West 6 210 1260 Net 

Banking
4

01/11/2025 Cardamom Spices South 2 520 1040 Credit 
Card

5

01/12/2025 Saffron Spices East 1 1600 1600 Cash 3
01/13/2025 Turmeric Spices North 7 195 1365 UPI 4
01/14/2025 Cardamom Spices South 5 480 2400 Cash 5
01/15/2025 Saffron Spices North 1 1500 1500 Net 

Banking
5

01/16/2025 Turmeric Spices East 8 205 1640 UPI 4
01/17/2025 Cardamom Spices South 6 450 2700 Credit 

Card
5

01/18/2025 Saffron Spices North 1 1600 1600 UPI 3
01/19/2025 Turmeric Spices South 9 200 1800 Net 

Banking
5

01/20/2025 Cardamom Spices West 3 510 1530 Cash 4

Table 4.2.7

Questions:

3.	 SUMIFS

a.	 Calculate the total sales for all Turmeric products.

b.	 Calculate the total sales for products sold through UPI with a Customer Rating 
of 5.
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2.	 AVERAGEIFS

a.	 Find the average price per unit for Cardamom.

b.	 Find the average total sales for Saffron with a Customer Rating of 4 or higher.

3.	 COUNTIFS

a.	 Count the number of transactions where Turmeric was sold in the North region.

b.	 Count the number of transactions where Total Sales > ₹1,500 and Customer 
Rating = 5.

4.	 AND

Create a new column titled “High-Value Sale (Yes/No)”. Mark “Yes” if Total Sales 
> ₹2,000 AND Customer Rating = 5, otherwise “No”.

5.	 OR

Create another column titled “Promotion Eligible (Yes/No)”. Mark “Yes” if the 
Region is North OR South, otherwise “No”.

6.	 NOT

Use the NOT function to create a column titled “Digital Payment (Yes/No)”. Mark 
“Yes” if the payment method is NOT Cash, otherwise “No”.

Deliverables:

1.	 Students should create an Excel file and enter the sales data provided.

2.	 Use the functions mentioned above to complete the tasks.

3.	 Present the results as separate calculations and columns in the spreadsheet.

4.	 Highlight and interpret key insights (e.g., Which material generates the highest 
total sales? Which payment method is most common for high-value sales?).

This exercise teaches students to apply logical functions, conditional formulas, and 
data analysis in a real-world scenario.

Solution to the above exercise:
                                                         

Table 4.2.8

Question No. Sub-Question Formula Result

1. SUMIFS
1.a Total sales 
for Turmeric

= S U M I F S ( G 2 : G 2 1 , 
B2:B21, "Turmeric")

₹11,985

1.b Sales via 
UPI, Rating 5

= S U M I F S ( G 2 : G 2 1 , 
H2:H21, "UPI", I2:I21, 5)

₹4,550
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2. AVERAGEIFS
2.a Avg. price 
for Cardamom

=AVERAGEIFS(F2:F21, 
B2:B21, "Cardamom")

₹482

2.b Avg. sales 
for Saffron 
(Rating ≥ 4)

=AVERAGEIFS(G2:G21, 
B2:B21, "Saffron", I2:I21, 
">=4")

₹1,650

3. COUNTIFS
3.a Count of 
Turmeric sales 
in North

=COUNTIFS(B2:B21, 
"Turmeric", D2:D21, 
"North")

     2

3.b Transactions 
> ₹1,500, 
Rating 5

=COUNTIFS(G2:G21, 
">1500", I2:I21, 5)

     7

4. AND
4.a High-Value 
Sale (Yes/No)

= I F ( A N D ( G 2 > 2 0 0 0 , 
I2=5), "Yes", "No")

See 
table 
given 
below

5. OR
5.a Promotion 
Eligible (Yes/
No)

=IF(OR(D2="North" , 
D2="South"), "Yes", 
"No")

See 
table 
given 
below

6. NOT
6.a Digital 
Payment (Yes/
No)

=IF(NOT(H2="Cash"), 
"Yes", "No")

See 
table 
given 
below

Results for Derived Columns (High-Value Sale, Promotion Eligible, Digital 
Payment)
                                                               

Table 4.2.9

Date
High-Value 

Sale (Yes/No)
Promotion 

Eligible (Yes/No)
Digital Payment 

(Yes/No)
01/01/2025 No Yes Yes
01/02/2025 No Yes No
01/03/2025 No No Yes
01/04/2025 No No Yes
01/05/2025 No Yes No
01/06/2025 Yes Yes Yes
01/07/2025 No No Yes
01/08/2025 No Yes Yes
01/09/2025 No No Yes
01/10/2025 No No Yes
01/11/2025 No Yes Yes
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01/12/2025 No No No
01/13/2025 No Yes Yes
01/14/2025 Yes Yes No
01/15/2025 Yes Yes Yes
01/16/2025 No No Yes
01/17/2025 Yes Yes Yes
01/18/2025 No Yes Yes
01/19/2025 Yes Yes Yes
01/20/2025 No No No

Summary of Insights:

◊	 High-Value Sales: Rows marked “Yes” are 6, 14, 15, 17, and 19.

◊	 Promotion Eligible: Majority of transactions in the North or South regions 
qualify for promotion eligibility.

◊	 Digital Payment Usage: 15 transactions were done using digital payment 
methods like UPI, Net Banking, or Credit Card.

◊	 Logical Functions: Use AND, OR, and NOT to test multiple conditions in 
datasets.

◊	 Conditional Functions: SUMIFS, AVERAGEIFS, and COUNTIFS help 
perform calculations based on multiple criteria.

◊	 Data Filtering: Functions simplify filtering and sorting of data for decision-
making.

◊	 Practical Application: Examples from nano businesses, such as identifying 
discounts or sales trends, show real-world relevance.

◊	 Efficiency: Using Excel functions enhances productivity and reduces 
manual errors in data management.

Recap

1.	 Which function is used to calculate the total based on multiple criteria?

2.	 What does the AND function return if all conditions are TRUE?

3.	 Name the Excel function that calculates the average based on multiple 
criteria.
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4.	 Which function counts cells that meet multiple conditions?

5.	 What is the maximum number of conditions you can use in an AND function?

6.	 Which logical function inverts the value of a condition?

7.	 What is the syntax for the SUMIFS function?

8.	 Name a scenario where the OR function is useful in nano businesses.

9.	 Which function is used to count the number of transactions meeting specific 
criteria?

10.	 Write the formula to find total revenue from “Saffron” in Excel.

11.	 How does the NOT function return a FALSE value?

12.	 Which Excel function is used for analyzing regional sales trends?

1.	 SUMIFS

2.	 TRUE

3.	 AVERAGEIFS

4.	 COUNTIFS

5.	 255

6.	 NOT

7.	 =SUMIFS(sum_range, criteria_range1, criteria1, ...)

8.	 Customer discount eligibility

9.	 COUNTIFS

10.	 =SUMIFS(C2:C100, A2:A100, “Saffron”)

11.	 When the condition is TRUE

12.	 COUNTIFS

Answers
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1.	 Explain how the AND function can be applied in managing discounts in 
small businesses.

2.	 Discuss the role of SUMIFS in analyzing financial trends within nano 
enterprises.

3.	 How does the AVERAGEIFS function improve decision-making for 
business owners? Provide examples.

4.	 Describe how the COUNTIFS function can be used to monitor inventory in 
small-scale operations.

5.	 Illustrate the practical use of logical functions (AND, OR, NOT) in a real-
world nano business scenario.

6.	 Logical Functions: Use the AND, OR, and NOT functions to analyze a dataset 
of customer orders, identifying eligibility for discounts or promotions.

7.	 SUMIFS Application: Calculate total sales for a specific product category 
and payment method in a sales dataset.

8.	 AVERAGEIFS Practice: Find the average sales revenue for high-rated 
products (rating ≥ 4) in a dataset.

9.	 COUNTIFS Use Case: Count transactions that meet multiple criteria, such 
as regional sales and specific product types.

10.	 Business Simulation: Create a spreadsheet for a nano business tracking 
sales, apply Excel functions to identify trends, and interpret results.
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1.	 Alexander, M., Kusleika, R., & Walkenbach, J. (2018). Microsoft Excel 
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2.	 Jelen, B. (2021). Microsoft Excel inside out (Office 2021 and Microsoft 
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      SREENARAYANAGURU OPEN UNIVERSITY

   MODEL QUESTION PAPER

QP CODE:..         		          SET – 01			                      Reg. No:…..

									              Name:……

SECOND SEMESTER BA NANO ENTREPRENEURSHIP EXAMINATION

ABILITY ENHANCEMENT COMPULSORY COURSE – 2 – B23CA02AC

SOFTWARE FOR OFFICE MANAGEMENT

(CBCS - UG)

2024-25 - Admission Onwards

Time: 3 Hours					                              Max Marks: 70

                                                     Section A

                             (Answer any 10, each carry 1 mark)

						                                                       (10x1=10)

1.	 What is Office Management?

2.	 What is filing?

3.	 Define google form.

4.	 How can forms be shared?

5.	 What do you mean by free software?

6.	 What is cloud integration?

7.	 What is OpenOffice Writer?

8.	 How can you create a hyperlink in Writer?

9.	 Define MS Word.

10.	 What are the main interface elements of MS Word?

11.	 Where can you find the Spelling & Grammar tool in MS Word?

12.	 What does the Accessibility Checker highlight?
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13.	 Define MS Excel

14.	 How new workbooks are created in Excel?

15.	 Which function is used to calculate the total based on multiple criteria?

16.	 What does the AND function return if all conditions are TRUE?

                                                      Section B

                                (Answer any 5, each carries 2 marks)

						                                                          (5x2=10)

17.	 Mention the difference between Vertical, Suspension and Lateral Filing.

18.	 What are the features of Add-Ons and Extensions in Google Forms?

19.	 What is Copyleft License?

20.	 What features are included in the menu bar of the writer window?

21.	 Mention the ways to find and replace text within a document. 

22.	 List formatting methods used in MS Word.

23.	 Which commands are used in the home tab of MS Word?

24.	 Where can you enable readability statistics in MS Word?

25.	 How to insert headers and footers in Excel?

26.	 What is the syntax for the SUMIFS function?

                                                       Section C

                               (Answer any 4, each carries 5 marks)

						                                                          (4x5=20)
27.	 Describe the Traditional System of Filing

28.	 Explain the features of Google Forms that make it a versatile tool for data 
collection.

29.	 Discuss the characteristics of free software.

30.	 Explain the main features and advantages of OpenOffice Writer for nano 
businesses

31.	 How do we create and save Word documents?

32.	 How can you use the Researcher tool to strengthen the credibility of your 
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document?

33.	 How importing data from various sources are allowed in Excel?

34.	 Explain how the AND function can be applied in managing discounts in small 
businesses.

                                                    
   Section D

                               (Answer any 2, each carries 15 marks)

						                                                        (2x15=30)
35.	 Explain in detail the Methods of Filing Systems and the Types of Indexing 

documents.

36.	 Explain in brief the advantages and disadvantages of free software. Mention its 
types in detail

37.	 Discuss the evolution and key milestones in the history of MS Word.

38.	 Explain the importance of using MS Excel in nano business operations.
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       SREENARAYANAGURU OPEN UNIVERSITY

   MODEL QUESTION PAPER

QP CODE:..         		                 SET – 02			          Reg. No:…..

									              Name:……

SECOND SEMESTER BA NANO ENTREPRENEURSHIP EXAMINATION

ABILITY ENHANCEMENT COMPULSORY COURSE – 2 – B23CA02AC

SOFTWARE FOR OFFICE MANAGEMENT

(CBCS - UG)

2024-25 - Admission Onwards

Time: 3 Hours					                              Max Marks: 70

                                                      Section A

                               (Answer any 10, each carry 1 mark)

						                                                        (10x1=10)

1.	 What is a page index?

2.	 What is the primary goal of indexing?

3.	 How many question types does Google form offer?

4.	 What is a multiple-choice grid?

5.	 What do you mean by open-source software?

6.	 What Internet of Things?

7.	 How can you cut, copy and paste text in Writer?

8.	 How can you insert special characters?

9.	 Mention QAT

10.	 What is a Navigation Pane?

11.	 What does Flesch Reading Ease measure?
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12.	 Which file format is ideal for web publishing?

13.	 How to insert and delete rows and columns in Excel?

14.	 How to copy and move a worksheet?

15.	 Which function counts cells that meet multiple conditions?

16.	 How does the NOT function return a FALSE value?

                                                      
 Section B

                                 (Answer any 5, each carries 2 marks)
						                                                         

(5x2=10)
17.	 What is the Strip Index?

18.	 What do you mean by dropdown in Google Forms?

19.	 What is permissive license?

20.	 What do you mean by hyphenating words?

21.	 How to format paragraphs in a document. 

22.	 What is the use of the document area in Word?

23.	 What are the features of the status bar?

24.	 What is the benefit of saving a document as a PDF?

25.	 How can we change workbook themes?

26.	 Which Excel function is used for analyzing regional sales trends?

                                                     
    Section C

                                 (Answer any 4, each carries 5 marks)

						                                                          (4x5=20)
27.	 Explain the Modern System of Filing.

28.	 Illustrate the steps to create and share a Google Form.

29.	 Explain the uses of free software.

30.	 Highlight the practical applications of OpenOffice Writer in creating business 
documents.

31.	 How formatting of texts and paragraphs done in MS Word?
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32.	 Discuss the advantages of saving a document in different formats.

33.	 How create and format charts in Excel?

34.	 Describe how the COUNTIFS function can be used to monitor inventory in 
small-scale operations.

                                                       Section D

                               (Answer any 2, each carries 15 marks)

						                                                        (2x15=30)

35.	 Evaluate the features and applications of Google Forms in different domains.

36.	 Explain in detail how to Add hyperlinks to a document: link one section to 
another and include external links to a website or email address.

37.	 Use the Researcher tool to find three sources on a given topic and insert citations 
into a document.

38.	 Create a spreadsheet for a nano business tracking sale, apply Excel functions to 
identify trends, and interpret results.
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